Contents

Send Us Your Comments

Preface

1 Getting Started with Oracle E-Business Suite
   Introduction ........................................................................................................... 1-1
   Getting Started ................................................................................................. 1-1

2 HTML-Based Applications
   Using HTML-Based Applications ....................................................................... 2-1
   Querying and Viewing Data ............................................................................... 2-4
   Entering Data ..................................................................................................... 2-9
   Scheduling Requests and Request Sets ............................................................. 2-11
   Monitoring Requests ......................................................................................... 2-11
   Using Attachments ............................................................................................ 2-11
   Personalizations .................................................................................................. 2-13

3 Forms-Based Applications
   Using Forms-Based Applications ....................................................................... 3-1
   The Forms Toolbar ............................................................................................. 3-4
   Entering Data in Forms ....................................................................................... 3-5
   Searching for Data ............................................................................................. 3-11
   Customizing the Presentation of Data ............................................................... 3-13
   Running Reports and Programs ........................................................................ 3-15
   Monitoring Requests ......................................................................................... 3-18
   Viewing Request Output ..................................................................................... 3-20
Exporting Records to a File........................................................................................................ 3-21
Oracle E-Business Suite Attachments.................................................................................. 3-22
Defining Preferences with User Profile Options................................................................. 3-23

4 Enterprise Command Centers

Overview of Enterprise Command Centers......................................................................... 4-1
Using Enterprise Command Centers.................................................................................... 4-3
Highlights of an Enterprise Command Center.................................................................. 4-4
  Page Layout.......................................................................................................................... 4-4
  Search.................................................................................................................................. 4-4
    Saved Search...................................................................................................................... 4-16
  Data Visualization................................................................................................................ 4-18
  Detailed Insights................................................................................................................ 4-32
  Export.................................................................................................................................. 4-37
  Page Display Preferences................................................................................................. 4-40

A Using Help

Getting Help.......................................................................................................................... A-1
Searching For Help................................................................................................................. A-1

B Oracle E-Business Suite Accessibility Features

Overview................................................................................................................................. B-1
  Enabling Accessibility Features for the HTML-Based Interface....................................... B-1
  Keyboard Interaction in the HTML-Based Interface ....................................................... B-2
  Accessibility in Forms-Based Applications....................................................................... B-12
  Keyboard Interaction in the Oracle Enterprise Command Center Dashboards.............. B-18
Send Us Your Comments

Part No. E22956-20

Oracle welcomes customers' comments and suggestions on the quality and usefulness of this document. Your feedback is important, and helps us to best meet your needs as a user of our products. For example:

- Are the implementation steps correct and complete?
- Did you understand the context of the procedures?
- Did you find any errors in the information?
- Does the structure of the information help you with your tasks?
- Do you need different information or graphics? If so, where, and in what format?
- Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell us your name, the name of the company who has licensed our products, the title and part number of the documentation and the chapter, section, and page number (if available).

Note: Before sending us your comments, you might like to check that you have the latest version of the document and if any concerns are already addressed. To do this, access the new Oracle E-Business Suite Release Online Documentation CD available on My Oracle Support and www.oracle.com. It contains the most current Documentation Library plus all documents revised or released recently.

Send your comments to us using the electronic mail address: appsdoc_us@oracle.com

Please give your name, address, electronic mail address, and telephone number (optional).

If you need assistance with Oracle software, then please contact your support representative or Oracle Support Services.

If you require training or instruction in using Oracle software, then please contact your Oracle local office and inquire about our Oracle University offerings. A list of Oracle offices is available on our Web site at www.oracle.com.
Preface

Intended Audience


This guide assumes you have a working knowledge of the following:

• The principles and customary practices of your business area.

• Computer desktop application usage and terminology.

If you have never used Oracle E-Business Suite, we suggest you attend one or more of the Oracle E-Business Suite training classes available through Oracle University.

See Related Information Sources on page viii for more Oracle E-Business Suite product information.

Documentation Accessibility

For information about Oracle’s commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support

Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.

Structure

1 Getting Started with Oracle E-Business Suite
2 HTML-Based Applications
Related Information Sources

This book is included in the Oracle E-Business Suite Documentation Library. If this guide refers you to other Oracle E-Business Suite documentation, use only the latest Release 12.2 versions of those guides.

Online Documentation

All Oracle E-Business Suite documentation is available online (HTML or PDF).

- **Online Help** - Online help patches (HTML) are available on My Oracle Support.

- **Oracle E-Business Suite Documentation Library** - This library, which is included in the Oracle E-Business Suite software distribution, provides PDF documentation as of the time of each release.


- **Release Notes** - For information about changes in this release, including new features, known issues, and other details, see the release notes for the relevant product, available on My Oracle Support.


Related Guides

You should have the following related books on hand. Depending on the requirements of your particular installation, you may also need additional manuals or guides.

**Oracle Alert User's Guide**

This guide explains how to define periodic and event alerts to monitor the status of your Oracle E-Business Suite data.

**Oracle Workflow User's Guide**

This guide describes how users can view and respond to workflow notifications and
monitor the progress of their workflow processes.

Integration Repository

The Oracle Integration Repository is a compilation of information about the service endpoints exposed by the Oracle E-Business Suite of applications. It provides a complete catalog of Oracle E-Business Suite's business service interfaces. The tool lets users easily discover and deploy the appropriate business service interface for integration with any system, application, or business partner.

The Oracle Integration Repository is shipped as part of the Oracle E-Business Suite. As your instance is patched, the repository is automatically updated with content appropriate for the precise revisions of interfaces in your environment.

Do Not Use Database Tools to Modify Oracle E-Business Suite Data

Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data Browser, database triggers, or any other tool to modify Oracle E-Business Suite data unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and maintain information in an Oracle database. But if you use Oracle tools such as SQL*Plus to modify Oracle E-Business Suite data, you risk destroying the integrity of your data and you lose the ability to audit changes to your data.

Because Oracle E-Business Suite tables are interrelated, any change you make using an Oracle E-Business Suite form can update many tables at once. But when you modify Oracle E-Business Suite data using anything other than Oracle E-Business Suite, you may change a row in one table without making corresponding changes in related tables. If your tables get out of synchronization with each other, you risk retrieving erroneous information and you risk unpredictable results throughout Oracle E-Business Suite.

When you use Oracle E-Business Suite to modify your data, Oracle E-Business Suite automatically checks that your changes are valid. Oracle E-Business Suite also keeps track of who changes information. If you enter information into database tables using database tools, you may store invalid information. You also lose the ability to track who has changed your information because SQL*Plus and other database tools do not keep a record of changes.
Introduction

Oracle E-Business Suite is a complete set of business applications for managing and automating processes across your enterprise.

This chapter introduces features such as:

- Oracle E-Business Suite Home Page, page 1-1
- Settings, page 1-5

See also: My Oracle Support Knowledge Document 1155883.1, "Oracle E-Business Suite Desktop Client Hardware and Software Requirements".

Two Types of Interfaces

Oracle E-Business Suite applications are either HTML-based or Forms-based. HTML-based applications, sometimes referred to as "self-service applications", are optimized for ease of first-time use. Forms-based applications are optimized for processing a large volume of transactions. For example, to enter a batch of journals, the Oracle E-Business Suite provides a Forms-based application. To submit an expense report, the Oracle E-Business Suite provides an HTML-based application.

Getting Started

The Oracle E-Business Suite Home page is your entry point to Oracle E-Business Suite. To enable a preferred Home page style, set the preference Home Page Style to "Framework Only", "Framework Tree" or "Framework Simplified".
Oracle E-Business Suite Configurable Home Page with Tree-Based Navigator and Global Header with Iconized Buttons
1. Navigator

2. Favorites

3. Settings

4. Worklist (Workflow Notifications)

If available, the Contact Admin button can be used to generate an alert for an administrator in Oracle Applications Manager. See: User Initiated Alerts, Oracle E-Business Suite Maintenance Guide.

From the Home page you can:

1. Access Oracle E-Business Suite functions from the Navigator. In the Simple Home page, select the global Navigator button to display the Navigation menu with Search input.

2. Navigate to frequently-used functions or Web pages from Favorites.

3. Select the global Settings button to access Preferences and other global setting functions from a menu.

4. View or respond to your most recent notifications from the Worklist.
**Note:** If you have privileges to create administrative-level personalizations, refer to Overview of Administrative-level Personalizations, *Oracle Application Framework Personalization Guide* for more information on the **Personalize Page** feature.

**Note:** The global Navigator and Favorites buttons must be enabled by your system administrator through the profile option **FND: Disable Navigator and Favorites Rich Menu** in order for you to see them.

**Note:** If the Preferences menu option does not appear, contact your system administrator to enable this feature with profile option **General Preferences Show Flag**.

**Using the Navigator**

Use the **Navigator** to access Oracle E-Business Suite functions grouped by responsibility. In the Simple Home page, select the global **Navigator** button to invoke a drop-down menu of responsibilities and functions.

**Note:** A **responsibility** is a level of authority in Oracle E-Business Suite. It enables your access to those functions and data appropriate for your enterprise role. You can have one or more responsibilities.

**To access a function**

1. Select a responsibility to view its menu of functions.
2. Select the function to launch it.

**Note:** Enter characters for a function name in the Search field to find the function. The minimum number of characters needed to start the search is determined by a profile option set by your system administrator.

To show or hide responsibilities shown in the **Navigator** region from all responsibilities available to you, select the **Personalize** button. To personalize the **Navigator** in the Simple Home page, select the global **Navigator** button, then select the **Personalize Navigator** icon in the drop-down **Navigator** menu.

**Managing Favorites**

Your system administrator may have defined Default Favorites for you.

You can customize your Favorites by adding links to frequently-used functions and websites.
Note: This feature must be enabled by your system administrator through the profile option FND: Disable Navigator and Favorites Rich Menu.

There are three main ways you can do this type of customization:

- Select the Manage Favorites icon from the drop-down menu of the global Favorites button.

- Select the Add Favorites icon on the Simple Home page. You can select from the following:
  - Suggested Favorites: suggestions from an administrator (if any)
  - Popular Favorites: top bookmarked functions of other users

- Use the Add to Favorites icon for bookmarkable pages (pages that can be accessed without being in an HTML-based application).

If you are adding a link to a website, you can specify whether to open the URL in a new window.

Specifying Settings

The global Settings button has a drop-down menu with options such Personalize Page, Preferences, Diagnostics, Manage Proxies and Access Requests.

- Select Preferences to set personal options, including language, territory, time zone, notification style, accessibility setting, and formats for dates and numbers. You can also reset your password from the Preferences page.

  Optionally specify a Page Header Display Style for the global header. Options are:
  - Both Links and Icons
  - Icons Only
  - Links Only

  Optionally specify a Top-level Menu Display Style. Options are:
  - Icons and Links - First-level menu choices appear as icons.
  - Icons and Links on Tablets Only - First-level menu choices appear as icons with links on a tablet, but as classic tabs with links on a desktop/laptop.
  - Links Only - First-level menu choices appear as classic tabs with links on all devices.
Optionally specify a username and password for Delivery Manager to use for concurrent request output. For information on Delivery Manager, see Delivery Options for Concurrent Request Output, Oracle E-Business Suite Setup Guide.

Optionally specify a Start Page for future sessions from a list of available pages (organized by responsibility).

**Note:** From the Forms interface, change your Start Page using the "Applications Start Page" profile option.

Set additional preferences using user profile options. For more information, see Defining Preferences with User Profile Options, page 3-23.

For example, set the profile option `FND: Show Instance Name` to "True" to display the instance name on the home page.

- Access Oracle Diagnostics features, if enabled.

- If you use the Proxy User feature, navigate to the Manage Proxies and Access Requests functions.

### Using Worklists

Depending on the features and Home page style enabled in your instance, the global **Worklist** button or **Worklist** region may appear.

You can check your count of open notifications and view your most recent notifications from the global **Worklist** button. In the My Worklist menu, select a notification subject to view details and respond, or select Go To Full Worklist to see all your notifications.

If quick action buttons appear in the My Worklist menu, choose **Approve** or **Reject** to respond to an approval notification, or choose **OK** to dismiss an FYI notification. To enable or disable these buttons, set the WF: Enable Worklist Global Header Quick Actions profile option.

The **Worklist** region displays your most important notifications. Select a **Subject** to view details and respond, or select the **Full List** button to see all of your notifications.

The number of open notifications waiting for response is shown.

For more information about worklist features, see Accessing the Oracle Workflow Self-Service Home Page, Oracle Workflow User’s Guide.
Using HTML-Based Applications

HTML-based applications use many common components in the user interface (UI):

UI Components in HTML-Based Applications
More UI Components in HTML-based Applications

Navigating

Navigate to functions in an HTML-based application using tabs, subtabs, and side navigation elements. As you drill down through these elements, locator links display your navigation path.

When you navigate through steps of a task, use the **Back** and **Next** buttons.
**Important:** Use these forward and backward navigation elements provided by the application. Do not use your browser's buttons.

**Multiple Browser Tabs**
Unless otherwise noted in your specific product or its documentation, using HTML-based applications over multiple tabs in the same browser is not supported. That is, you cannot access an application in multiple browser tabs and then perform concurrent independent transactions from these tabs.

**Top-level Menu**
The top-level menu entries can be displayed as links, or icons and links. You can choose your display choice in the Preferences page or by setting the FND: Top-Level Menu Display Mode profile option.

**Tiles**
A tile consists of a header box and an associated content region. Each tile provides a description of its detailed region. When you select a given tile, the details related to that tile are shown in the region.

**Process Train**
If you are executing a process, a process train shows the location of the current page in the process. Some process trains are interactive. These allow you to jump one or more steps backward in the process by selecting the step icon.

**Locator Links**
Locator links (sometimes called "breadcrumbs") are series of links and text that show your navigation path through an application. Use the links to return to a previous point in your navigation path.

**Tabs**
Available pages are presented as a series of tabs.

**Subtabs**
A subtab displays a single page's contents in a tabbed layout.

Subtabs can be displayed horizontally or vertically.

**Panel Splitter**
Some pages may have a panel splitter. With a panel splitter, a single region may be split into two separate resizable and collapsible regions, or panels, using a splitter bar.

**Layered Layouts**
Some pages have multiple layers instead of multiple subtabs. You can switch between layers using the title bar.

**Table Toolbar**
The table toolbar contains multiple table actions and settings as one Actions menu button which looks like an ellipsis (...) for manipulating the display of data in a table.

**Mobile Devices and Gesture Support**
HTML-based applications are certified with the Safari browser on Apple iPad and the
Chrome browser on Android tablets. See the "Mobile Applications" topic in the *Oracle Application Framework Developer’s Guide* available from My Oracle Support Knowledge Document 1315485.1 for caveats and known limitations before running on these platforms.

The following gestures are supported for these mobile devices:

- Single Tap
- Double Tap
- Hold/Press/Press and Hold
- Pan/Drag
- Swipe/Flick
- Spread
- Pinch
- Check Mark/Tick
- X-Mark/Cross

See the "Gesture Support" topic in the *Oracle Application Framework Developer’s Guide* available from My Oracle Support Knowledge Document 1315485.1 for a full description of these gestures and their use cases.

### Querying and Viewing Data

Pages that allow you to search for data display a **Search** panel that generally includes a search region and a results region.

Many search panels contain an **Advanced Search** button that allows more detailed searches using additional criteria.

When you enter characters in a search field, a wildcard is implicitly added to the end of the string.

**Note:** Enter exact values for number and date fields.

The results region displays search results in a table. Columns that are sortable have an arrow icon to indicate if the column is unsorted or sorted in ascending or descending order.

Click the column heading of a sortable column to sort by that column. Click it again to toggle between ascending and descending order.

Many pages allow you to save searches and personalize the display tables. See
If exporting is enabled, then you can select the Export Table Data to Excel icon for a table to create the corresponding spreadsheet. See: Creating a Spreadsheet, Oracle Web Applications Desktop Integrator Implementation and Administration Guide.

Using List Search

Some product pages allow you to search using filters and an associated List Search panel. You can search for records either using the filters provided or filters you have added. Some pages with List Search enabled also allow you to perform either a Quick Search based on a single field, or a Keyword Search based on predefined keywords.

The List Search feature also allows you to save your search criteria and manage your saved searches. For example, you can update the name of a saved search, set one saved search as your default search, or reorder the listing of saved searches.

Where List Search is enabled, you can sort the results in the table using the Advanced Sort window, in which you can specify up to three sort criteria and the sort direction.

**Note:** Ask your system administrator which product pages have List Search enabled.

Using a Hierarchical Grid (HGrid)

Components of an HGrid

1. Locator links define the position of the displayed grid in the navigation hierarchy.

2. Use the tri-state check box to select or deselect all of the rows.
3. Use the **Hide/Show** icon to expand and collapse the branches of the tree.

4. Use the **Focus** icon to display only a specific branch in the tree.

**Using a Rich Table or HGrid**

Rich tables and HGrids enable you to personalize how you interact with a table or HGrid and its data. With a rich table or HGrid, you can:

- Resize a column.
- Reorder columns.
- Scroll horizontally if the contents of a table exceeds the browser width.
- Freeze a set of columns to remain in view while horizontally scrolling.
- Vertically scroll a table.
- Hide/Show a column.
- Detach a table from the base page using the Detach Table icon. HGrids do not support table detaching.
- Reset a table back to its original definition.
- Refresh a table by querying for the latest records in case simultaneous modifications were made elsewhere.
- Select or deselect all of the rows using the tri-state check box in a Select column.
  The three states are:
  - Unchecked - when no row in current range is selected.
  - Checked - when all rows in current range are selected.
  - Partially checked - when some row(s) in current range are individually selected.

To use these features, you must have the following profile option set:

- **FND: Enable Rich Table Interactions** profile option to "True"
Using Query By Example on Tables

Components for Query By Example on Tables

1. Query By Example icon
2. Query By Example header row
3. Clear Filter icon

If available, you can use Query By Example (QBE) on tables to filter records based on query criteria.

Click the **Query By Example** icon to display the QBE header row.

Enter your filter into one of the text fields in the QBE header row, and select **Enter**.

Possible filter criteria include:

**Query Operators**

<table>
<thead>
<tr>
<th>Operator</th>
<th>Meaning</th>
<th>Example Expression</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>equals</td>
<td>= 'Janet', = 107</td>
</tr>
<tr>
<td>!= or &lt;&gt;</td>
<td>is not</td>
<td>!= 'Bob', != 109</td>
</tr>
<tr>
<td>&gt;</td>
<td>greater than</td>
<td>&gt; 99.1, &gt; '01-JAN-04'</td>
</tr>
<tr>
<td>&gt;=</td>
<td>at least</td>
<td>&gt;= 55</td>
</tr>
</tbody>
</table>
The character % allows you to perform a wildcard search on text fields. For example, 'P%' could return "Penelope" or "Peter".

You may also select a date filter or choose a filter from a list.

You can use multiple filters and then perform the query. "Match All" is applied for multiple filters. To clear a filter, use the **Clear Filter** icon.

If you wish to hide a column where a filter is applied, then clear that filter first.

### Exporting Table Data

Two related options allow you to export selected columns of table data:

- On any supported operating system, you can export to PDF.
- On Windows, you can export to Microsoft Excel.

**Note:** This feature must be enabled by your system administrator through the profile option *FND: Enable BNE Table Integration*.

### Using Accordions

Accordions allow for flexible access to multiple panels in a restricted screen area. Panels can be expanded or collapsed.

### Using Pop-up Windows

Pop-up windows provide additional information on top of the current page. They appear when you hover over an item or click on it with the left mouse button. Pop-up windows are available on some components of these types:

- Text
- Image
- Link
- Button
Entering Data

Entering Data in a List of Values (LOV) Field

Three basic options are available here:

- If you know the full value you are looking for in a field, enter it and press the Tab key.
- If you know the beginning of the value, start typing characters into the LOV field and then either select the desired value from the matches that are displayed inline by the look-ahead capability, or wait for the Search and Select page to launch.
- If you do not know any part of the value, choose the List of Values icon to launch the Search and Select page. Optionally, you can limit the results by entering a partial value first. If the partial value you enter matches only a single value, the field auto-fills and the Search and Select page does not launch.

**Note:** If it is available, the Look Ahead LOV is enabled by default. When it is enabled, a dimmed downward arrow appears in the lower right corner of the LOV field. The Look Ahead LOV can be disabled by your system administrator through a profile option.

**Note:** For some fields, the Look Ahead LOV includes searching on all search-allowed columns for the Look-Ahead LOV instead of only the first column.

Some Search and Select pages support alternative search criteria. You can use the Search by pulldown list to select a different search field. Enter the search string and select the Go button. Select the value from the Results region, and choose the Select button.

Some pages allow the display of multiple records which can then be selected individually.

LOV Choice List

When a field has a long list of possible values from which a small subset is commonly used, you may see an LOV choice list. The LOV choice list displays the most commonly-used values for easier selection and includes a More... option. Choosing More... launches the LOV Search and Select page.

When you choose a value that is not in the LOV choice list, it is added to the list.
Personalizing an LOV Choice List

An LOV choice list may allow you to customize the list with the values that you use most frequently.

To personalize an LOV choice list

1. Select the Personalize button next to the LOV choice list to open the Personalize page.

2. To add a value, select it and choose the Add button.

3. To delete a value, select the icon in the Delete column.
   
   **Note:** Some values cannot be deleted.

4. To reorder the list, select the Reorder button. In the Reorder page, select a value you want to move and use the Move icons to position it in the list. When finished, select the Apply button.

Entering Dates and Times

Enter a date directly in a field using the format defined in your Preferences. Alternatively, select the Calendar icon to launch the Date Picker pop-up window. When you select a date, the window closes and inserts the date into the field.

Some features allow you to specify a time while choosing a date from the Date Picker calendar.

Entering Data Through Desktop Integration

Some applications provide integrators that let you use a Microsoft Excel spreadsheet on your desktop to download, edit, and upload Oracle E-Business Suite data.


Using Flexfields

A flexfield is a flexible data field that can be customized by your enterprise. Oracle E-Business Suite uses two types of flexfields:

- Key flexfield - a field you customize to enter multi-segment values, such as part numbers or account numbers.

- Descriptive flexfield - a field you customize to enter additional information not provided by Oracle E-Business Suite.

Key Flexfields

A key flexfield is composed of segments, where each segment has both a value and a meaning. For example, an Accounting Flexfield can be composed of segments that represent Company, Department, and Account. The segments are delimited by a segment separator (usually a "." or a ":").

Descriptive Flexfields

A descriptive flexfield is also composed of segments and can have context-sensitive fields that appear only when needed.

Scheduling Requests and Request Sets

For information on how to schedule a request or request set, see Running Reports and Programs, page 3-15.

Monitoring Requests

The Monitor Requests pages provide a summary of requests and details of each request.

Select the Search button to specify your search criteria.

Related Topics

Monitoring Requests in Forms-Based Applications, page 3-18

Using Attachments

Use the Attachments feature to link text or other files to a record.

The method to initiate an Attachments flow will vary, depending on how the feature is implemented on your page.

With the Inline Attachments feature, if you hover over the Add icon or the Attachments icon, an inline window appears and allows you to add or view attachments in a table without navigating to the separate Attachments page. Text attachments can be edited inline. A badge on the Attachments icon indicates the number of attachments for that record. An Action list provides options to Update, Publish, Delete, Print, and Record History.

To add a new attachment

1. Using the Add poplist, select how you want to add the attachment:

   From a Desktop File/Text/URL
1. Select the attachment Type:
   - File - Specify a file name to upload. Enter the file location, or use the 
     **Browse** button to locate the file.
   - URL - Enter the URL for a Web page.
   - Short Text - Enter text that is less than 2000 characters.
   - Long Text - Enter text that is more than 2000 characters.

2. Select a **Category** from the list of values. The **Category** defines the purpose of 
an attachment, and controls which forms or pages can access it.

**From the Document Catalog**
1. Use the **Search** regions to query existing documents.
2. Select the **Document Name** link to view a document before attaching it.
3. Select the document(s) to attach.
4. Select the **Apply** button.

2. Give your attachment a title and description.

Save your work in the application page from which you launched the attachments flow. 
The attachments are not added until you save your work in the parent region.

**To view an attached document**
In the Attachments page or Attachments table, select the **File Name** link.
- If the attachment is a URL, the Web page will launch.
- If the attachment is a file, a dialog box prompts you to open or save the file.
- If the attachment is text, the View Attachment page displays the text content.

**To edit an attachment**
1. Display the Attachments page or Attachments table.
2. Select the **Update** icon (for the Attachments page), or choose **Update** from the 
   **Action** list (for inline attachments).
3. In the Update Attachment page, edit only the information as it pertains to the 
   attachment. For example, you can update the URL for a Web page attachment, but 
you cannot change it to a File attachment.
4. Select the **Apply** button.

5. Return to the application page from which you launched the attachments flow and save your work.

   **Tip:** Attachment updates must be saved in the associated parent region.

**To delete a record’s attachment**

In the Attachments page, select the **Delete** icon. For inline attachments, select **Delete** from the **Action** list.

**Using the Document Catalog**

Only Standard and Template documents can be retrieved from the Document Catalog. The catalog is accessed from the Attachments page which is configured with associated categories. There are two criteria for the Templates and Standard documents that are retrieved - they must be associated with the categories associated with the function and the security context must be set if the document is secured.

When creating attachments directly using the Attachments page, the document is created as a One-Time document. One-Time documents are not available in the Document Catalog. To publish the document to the catalog for sharing, select the option **Publish to Catalog** and select the option to publish as a Standard document or Template. If you choose Standard, the document is converted to a Standard document. If you choose Template, a copy is made of the document.

A document may be removed from the Document Catalog by deleting or end-dating it in the Documents window.

**Personalizations**

Some tables allow you to save queries and personalize the presentation of data. If a table can be personalized, you see the **Views** panel or the **Save Search** button.

   **Note:** Pages can have predefined personalizations available from the **View** list. Some pages with no personalizations saved do not show the **Views** panel until a search has been saved.

**Personalizing Tables**

   **To create a personalized view**

   1. Use the search panel to query for results in the table.
2. Select the Save Search button or the Views button.
   - The Save Search button launches the Create View page.
   - The Views button displays the Views panel. Select the Personalize button to launch the Personalize Views page. This page displays existing views. Select the Create View button to launch the Create View page.

3. On the Create View page, enter a View Name.

4. Specify the number of rows to display in the table.

5. Choose the Set as Default check box to make this view the default when you navigate to this page.

6. Personalize other available options.
   
   **Note:** Personalizable options vary by table. Some tables allow you only to save the search criteria. Others allow you to change more options, such as columns displayed, column order, sort order, and headings.

7. Select the Apply button.

**To duplicate, update, or delete a personalized view**

1. Select the Personalize button to launch the Personalize Views page.

2. Select the view from the list.
   - Select Update to update the options for this view.
   - Select Delete to delete the view.
   - Select the Duplicate button to create a duplicate of the selected view. Enter a new View Name. Make other modifications as desired and select Apply.

---

**Personalization Workbench**

The Personalization Workbench provides an alternative page that allows you to reorder components or change prompts in-place. For more information see the Oracle Application Framework Personalization Guide.

**Administrator Personalizations**

Administrators can make additional personalizations for you, including:
• Apply a shipped theme or create a new theme using Theme Editor to change the look and feel. See: Theme Editor, Oracle Application Framework Personalization Guide.

• Use the Custom Look-and-Feel (CLAF) feature. See: Customizing Look-and-Feel (CLAF), Oracle Application Framework Personalization Guide.

• Change data table properties and other UI features. See: Administrative-Level Personalizations: Overview, Oracle Application Framework Personalization Guide.
Using Forms-Based Applications

This chapter describes the user interface features that are common to Oracle E-Business Suite Forms-based applications, including:

- List of Values (LOV), page 3-7
- Flexfields, page 3-9
- Search (Query) functions, page 3-11
- Folders, page 3-13
- Concurrent Requests, page 3-15
- Export, page 3-21
- Attachments, page 3-22
- User Profile Options, page 3-23
From the **Navigator** you can:

1. Open forms from the **Functions** tab.
2. Link to documents from the **Documents** tab.
3. Launch business processes from the **Processes** tab.
Open Forms

The Functions tab provides links to the forms accessible to your current responsibility. To open a form, expand the function heading and double-click the form name.

Create a Top Ten List

Add forms that you use frequently to your Top Ten List. Create a different top ten list for each of your responsibilities.

To add a form to the Top Ten List

- Select the form, then select the Add to List button or choose Add to List in the Tools menu.

To remove a form from the Top Ten List

- Select the form, then select the Remove from List button or choose Remove from List in the Tools menu.

Create Links to Documents

Create links to documents that you are working on for faster access. The Documents tab allows you to save as many links as you want. View the saved links as a list or as icons.

To add a document that is currently open

- Choose Place on Navigator from the File menu

Important: The Place on Navigator command is not enabled for all forms.

To rename a link that you have created

1. Select its name (or icon) and select the Rename button.

2. Enter the new name in the Rename Label window and click OK.

To remove a document from the Documents tab

- Select its name (or icon) and select the Remove button.

Launch Business Processes

The Processes tab contains interactive step-by-step maps of business processes. Each step is a form or report that you can launch directly from the process map.

Each time you launch a business process, you create an instance of that process and assign it a name. As you complete each step in a process, the map is updated accordingly.
To open a process

1. Select the process, then select the **Launch** button.

2. Enter a name for the new instance.
   
   The instance remains active until you complete or cancel it. The **Processes** tab lists your active instances.

Working in a Process Instance

The active step has a box drawn around it. More than one step can be active if your process contains multiple paths.

- Click once on a step icon to display a description of the step.
- Double-click on a step icon to open the related form.
- Advance to the next step of a process from within a form by using the **Next Step** toolbar icon.

The Forms Toolbar

**Toolbar Icons**

The toolbar is a set of iconic buttons that allow quick access to common functions that are also on the menu.

The toolbar icons and the actions they perform are as follows:

1. The **New** icon opens a new record.

2. The **Find...** icon invokes the **Find** window.

3. The **Show Navigator** icon invokes the **Navigator** window.

4. The **Save** icon saves your data.

5. The **Next Step** icon advances you to the next step of a process. See Launch Business Processes, page 3-3.

6. The **Switch Responsibilities** icon invokes the list of your responsibilities for you to
choose another.

7. The Print... icon prints the current screen. In some cases it may print a report associated with the current data.

8. The Close Form icon closes all windows of the current form.

9. The Cut icon cuts the current selection to the clipboard.

10. The Copy icon copies the current selection to the clipboard.

11. The Paste icon pastes from the clipboard into the current field.

12. The Clear Record icon erases the current record from the form.

13. The Delete icon deletes the current record from the database.

14. The Edit Field... icon displays the Editor window for the current field.

15. The Zoom icon invokes customer-defined drill-down behavior.

16. The Translations... icon invokes the Translations window. See Creating Translations for a Record, page 3-10.

17. The Attachments icon invokes the Attachments window. If attachments already exist, the icon appears as a paperclip holding paper. See Attachments, page 3-22.


19. The Window Help icon invokes online help for the current window.

**Entering Data in Forms**

Use the following form components to enter and query data:
Form Components

1. Single-Row Block
2. Multi-Row Block
3. Folder Indicator
4. Current Record Indicator
5. Record
6. Field
7. List of Values Indicator
8. Descriptive Flexfield
9. Master-Detail Coordination Box.

Organization of a Form

Field

Use fields to enter, view, update, or delete information.

By default, a required field is displayed in yellow, and a read-only field is displayed in
gray. These colors can be changed or turned off using profile options. See Defining Preferences with User Profile Options, page 3-23.

In some cases, the display size of a field is too small to show the entire field contents. Use the **Edit Field** toolbar icon to view and update these fields.

**Record**

A record is a logical grouping of fields. A record is also referred to as a row or a transaction, since one record corresponds either to a row in a database table or to a transaction.

You must complete all required fields in a record before moving to the next record.

**Tip:** If you unintentionally enter a record and cannot advance your cursor, clear the record. From the **Edit** menu, choose **Clear**, then **Record**.

**Block**

A block displays a set of records either in a single-row format or a multi-row format.

**Tip:** To clear data at the block level: From the **Edit** menu, choose **Clear**, then **Block**.

**Creating and Deleting Records**

**To create a record**

1. Choose **New** from the **File** menu, or use the **New** toolbar icon.

2. After entering data for your new record, choose **Save** or **Save and Proceed** from the **File** menu to save the record to the database. Choosing **Save and Proceed** automatically advances you to the next record.

**To delete a record**

1. Choose **Delete** from the **Edit** menu.

   This action erases the current record from your screen, and returns your cursor to the first field of the next record.

2. To delete the record from the database, choose **Save** or **Save and Proceed** from the **File** menu.

**Using a List of Values (LOV)**

A field that has a predefined list of valid values displays an LOV icon. Select this icon to view the valid field values.
If a list contains more than 100 values, you are prompted to enter a **Find** string to limit the list.

**To choose a value from a list**

Select a value, or reduce the list using one of the following methods:

- Without placing your cursor in the **Find** field, type the initial character(s) of a value to *autoreduce* the list to those items matching the characters entered. Use the Backspace key to re-expand the list. If your entry reduces the list to a single value, the list window closes and inserts the value into the field.

  **Note:** Lists that require a **Find** string do not use the autoreduce feature.

- In the list window, enter any group of characters in the **Find** field and select the **Find** button.

  **Note:** Use the wildcard character (%) to represent any number of characters, and the underline (_) to represent a single character. Do not enter a wildcard character by itself. This will match all records.

---

**Power List**

Power List enables you to enter a search string or partial value in an LOV field without opening the list window.

**To use Power List**

Enter the initial characters of a value in the field and press the Tab key. Power List completes the entry for you.

Your entry can include wildcard characters.

If more than one value matches the characters you specify, a list window opens containing those values.

---

**Advanced Data Entry Features**

**Master-Detail Relations**

A **Master-Detail relation** is an association between two records. An example is the relationship between the **Batch** and **Journals** records in Oracle General Ledger. Each batch (master record) is associated with a set of journal entries (detail records).

Some master-detail blocks contain a coordination check box that allows you to choose whether detail records are queried. Select the master-detail coordination check box to automatically coordinate the update of records between the master and detail blocks. If you deselect the check box, the detail data is not displayed until you move your cursor into the detail block.
Drill-Down Indicators

Some records provide additional details in separate, drill-down windows.

A wide-width current record indicator designates that a record provides drill-down information. Double-click the indicator to open the detail window.

Flexfields

A flexfield is a flexible data field that can be customized by your enterprise. Oracle E-Business Suite uses two types of flexfields:

- Key flexfield - a field you customize to enter multi-segment values, such as part numbers or account numbers.

- Descriptive flexfield - a field you customize to enter additional information not provided by Oracle E-Business Suite.

Key Flexfields

A key flexfield is composed of segments, where each segment has both a value and a meaning. For example, an Accounting Flexfield can be composed of segments that represent Company, Department, and Account. The segments are delimited by a segment separator (usually a "," or a ":").

A range flexfield is a type of key flexfield in which you can input a low and a high value for each segment to express a range of combinations.

A key flexfield looks like any other field. You can enter the segments directly or use the Flexfield window to enter each segment separately.

To enter data directly into a key flexfield

- Enter the segment values, separating each with the segment separator.

To enter data using the flexfield window

1. Select the List of Values icon to open the flexfield window, or select the Edit Field... toolbar icon.

2. Enter a value for each segment, or use the list of values where available.

3. Select the Combinations button in the flexfield window to search the list of existing segment combinations.

To enter data in a range flexfield

- Enter a Low and a High value for each segment, or use the list of values where available.

Note: The Flexfields: Open Key Window On Default profile option controls whether a flexfield window opens when you press Tab to leave a
concatenated key flexfield.

If this profile option is set to Yes, the window opens if at least one of the segments has a default value defined. When you tab from the concatenated flexfield, the code automatically defaults defined values and opens the window to allow you to make changes.

If the profile option is set to No, then the flexfield window will not open for modifications, and assumes you want the defaulted values as part of the combination.

Descriptive Flexfields
A descriptive flexfield appears as a two-character, unnamed field enclosed in brackets. Move your cursor into the bracketed field to open the descriptive flexfield window. The window contains segments that make up the descriptive flexfield. Each segment can have a list of values.

To enter data in a descriptive flexfield
1. Open the descriptive flexfield window. If your profile option Flexfields:Open Descr Window is set to "No", or if you are in a folder, select the Edit Field... toolbar icon to open the flexfield window.

   Note: For more information on profile options, see Defining Preferences with Personal Profile Options, page 3-23.

2. Enter a value for each segment, or use the list of values where available. Default values can be overwritten.

Creating Translations for a Record
Windows that allow the entry of records in multiple languages display the enabled Translations... toolbar icon.

To enter a translation for a record
1. Select the record you wish to translate.

2. Select the Translations... icon from the toolbar.
   The Translations window opens, with translatable fields displayed in columns. The installed languages are displayed in rows.

3. Enter translations for the displayed fields.

Using Keyboard Help
Use keystroke combinations to perform many menu functions.
To view the list of functions and keystroke combinations

- Choose Keyboard Help... from the Help menu.

Searching for Data

To query records in your current block or window, use the Find command or Query by Example.

The Find Command

The Find command displays a window in which you can specify search criteria. Depending on the block that you invoke Find from, one of two types of windows appears:

- A find window that contains fields for entering search criteria.
- A list window that shows all possible records that you can retrieve for the block.

Generally, a find window appears for a multi-record block, while a list window appears for a single-record block.

Using the Find Command

- Choose Find... from the View menu or select the Find toolbar icon.
  - If a list window appears:
    - Use a list window as you would an LOV window. See Using a List of Values (LOV), page 3-7.
  - If a find window appears:
    1. Enter as many search criteria as you can.
    2. Select the Find button.

Query by Example

To retrieve a group of records based on more sophisticated search criteria than Find allows, use Query by Example. Query by Example allows you to specify search criteria in any of the queryable fields in the current block. The search criteria can include specific values, phrases containing wildcard characters, or query operators.

If you do not need to retrieve the records, but only want to know how many records match your search criteria, perform a query count.
Using Query by Example

1. From the View menu, choose Query by Example, then Enter.
   This action switches your window from data entry mode to Enter Query mode. Queryable fields are displayed in blue.

2. Enter search criteria in the queryable fields. (Fields may be case-sensitive). To reuse criteria from your last search: From the View menu, choose Query by Example, then Show Last Criteria.

   **Important:** In Enter Query mode, all check boxes are initially in a null state. To use a check box as a search criterion, you must explicitly check or uncheck it.

3. To perform the search: From the View menu, choose Query by Example, then Run.

4. To exit Enter Query mode without searching: From the View menu, choose Query by Example, then Cancel.

**To perform a query count**

1. Perform steps 1 and 2 from the previous task: "To use Query by Example".

2. From the View menu, choose Query by Example, then Count Matching Records. The window’s message line displays the number of matching records.

**Query Operators**

The following table shows the query operators for most fields, their meanings, and an example expression:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Meaning</th>
<th>Example Expression</th>
</tr>
</thead>
<tbody>
<tr>
<td>=</td>
<td>equals</td>
<td>= 'Janet', = 107</td>
</tr>
<tr>
<td>!=</td>
<td>is not</td>
<td>!= 'Bob', != 109</td>
</tr>
<tr>
<td>&gt;</td>
<td>greater than</td>
<td>&gt; 99.1, &gt; '01-JAN-04'</td>
</tr>
<tr>
<td>&gt;=</td>
<td>at least</td>
<td>&gt;= 55</td>
</tr>
<tr>
<td>&lt;</td>
<td>less than</td>
<td>&lt; 1000.00</td>
</tr>
<tr>
<td>Operator</td>
<td>Meaning</td>
<td>Example Expression</td>
</tr>
<tr>
<td>----------</td>
<td>---------------</td>
<td>---------------------</td>
</tr>
<tr>
<td>&lt;=</td>
<td>at most</td>
<td>&lt;= 100</td>
</tr>
<tr>
<td>#BETWEEN</td>
<td>between two values</td>
<td>#BETWEEN 1 AND 1000</td>
</tr>
</tbody>
</table>

### Customizing the Presentation of Data

Folder blocks allow you to personalize a form. You can define a query, customize the layout of the form columns, and then save the query and layout in a folder definition that can be retrieved later.

Folder blocks display an **Open Folder** button. When you move the cursor into a folder block, you enable the **Folder Tools** toolbar icon and the **Folder** menu.

**Important:** If your system administrator sets the profile option *Folders: Allow Customization* to "No", you cannot create or customize folders. The only item available from the **Folder** menu is **Open**, to open a predefined folder. For more information about profile options, see Defining Preferences with User Profile Options, page 3-23.

### Query Criteria for a Folder

**To define query criteria for a folder**

1. Run a query, either by using the **Find** command or **Query By Example**.
2. Save your query criteria by choosing **Save As** from the **Folder** menu.
3. Enter a name for the folder.
4. Select **Always**, **Never**, or **Ask Each Time** from the **Autoquery** option group to define how frequently to perform the saved query.
5. Select the **Open as Default** check box to set this folder definition as the default every time you navigate to this form.
6. Select the **Public** check box to allow other users to access your folder definition. Selecting **Public** does not enable other users to modify your folder.
7. Select the **Include Query** check box to include your query in the folder definition. If you do not select this check box, only the folder layout is saved.
To view the query criteria for a folder

- Choose View Query from the Folder menu.

The Folder Query window displays the query used to retrieve the records displayed in the folder. An empty window indicates that the folder retrieves all records.

To reset the query criteria for a folder

1. Choose Reset Query from the Folder menu.

   This clears the query from the current folder, but retains the current folder name and field layout.

2. Perform another query and choose Save from the Folder menu to save the new query to your current folder.

Customizing the Layout of a Folder

Use the Folder menu or the Folder Tools window to customize the folder layout. Some layout changes can be made using the mouse, such as:

- Column width, by dragging the column border.

- Column sequence, by dragging the column heading to a new position.

- Column name, by right-clicking the mouse on the column heading and entering the new name at the prompt.

To access the Folder Tools window

- Select the Folder Tools toolbar icon, or choose Folder Tools from the Folder menu.

Managing Folder Definitions

To create a new folder

1. Choose New from the Folder menu.

2. Enter a new folder name. The name must be unique for the Oracle E-Business Suite sign-on you use and for the entity that the folder represents.

3. Select an Autoquery option.

4. Select Open as Default if you want this specific folder definition to open as your default each time you navigate to this folder for the first time after invoking the form.

5. Select Public if you want other users to have access to this folder definition. They can use it as their default folder, but only you can modify it.
To recover the original default folder definition for a folder block
1. Select **Save As** from the **Folder** menu when you are in the custom default folder.

2. Uncheck **Open as Default** in the **Save As** window that appears.

3. Choose **OK**.

4. To display the original default folder definition, close and reopen the form.

To open another folder
1. Choose **Open** from the **Folder** menu to load a predefined folder.

2. Select a private or public folder from the list window that appears and choose **OK** to replace the current folder with the new folder.

To save changes to a folder
1. Select **Save** from the **Folder** menu to save any layout or query changes made to the current folder or choose **Save As** from the **Folder** menu to save the current folder under a new name.

2. If you choose **Save As**, complete the information requested in the **Save Folder** window that appears and choose **OK**.

To delete a folder
1. Choose **Delete** from the **Folder** menu.

   You can only delete folders you have created.

   If another user is referencing that folder definition as their "Open as Default" folder, that reference gets deleted as well.

Running Reports and Programs
A report or a concurrent program can be scheduled and submitted as a single request, or you can schedule and submit multiple reports and programs together as a request set.

*Important:* The navigation path you use to schedule and submit requests varies by application. Some of the options mentioned may not be available based on the selected request or your responsibility. Some functions automatically submit a request when you choose a specific button or save your work.

Request Submission

1. Choose the **Program Name** from the list of available requests and then enter a **Request Name**, which can be used later to search and monitor your request.
Use the **Copy...** option to choose and submit a request that you have previously submitted from this responsibility.

2. Define parameters.

If a request requires parameter values, the **Parameters** window opens. Enter the values in the required parameter fields.

   **Note:** Your user profile option *Flexfields:Open Descr Window* must be set to "Yes". See Defining Preferences with User Profile Options, page 3-23.

3. Determine the output language.

If your site supports multiple languages, select the language for your request output.

Choose the **Language Settings...** button to open the **Languages** window. If the language selection is predefined in the report, the **Language Settings...** button is not enabled.

In the **Languages** window select the **Language**, **Territory**, **Numeric Character**, and **Sort** settings appropriate for your report.

Select the **Select All** button to produce output in all languages supported at your site or to check individual languages.

   **Important:** Each language creates its own request, so the number of languages determines the number of requests created and tracked in the **Requests** window.

4. Define a schedule.

Specify when you would like your request to run. You can choose a simple schedule such as, *as soon as possible, a specific date and time, or recurring intervals*; or you can choose a more advanced schedule such as *specific days of the week or specific dates in a month*. You can also choose a previously saved schedule.

   **Note:** If you do not select an end date for the more advanced schedules, the request will continue to run until it is cancelled.

5. Define the layout.

   - **Template Name** - If the request has multiple layout templates available, you can select a different template to apply to the request.

     If you selected multiple language outputs from the **Languages** window, a
separate template entry displays for each language. You can apply a different template for each language.

- **Template Language** - This field defaults to the language selected for the request. If the template is not available for a selected language, this field defaults to the session language.

- **Format** - The output format selection varies by template. Some options are PDF, RTF, and HTML.

- **Preview** - If sample data is available for the request, select the Preview button to display the selected template with the sample data.

  **Additional Information:** Select the Options... button to change the default layout, notification, and output options.

6. **Notify employees.**

Choose the employee name from the list of available employees, and then choose the circumstance of when to notify this employee. This option sends an E-mail notification, with a link to the request, based on if the request ran normally or resulted in a warning or error.

7. **Print the output to:**

For printed output, select the print style, printer, copies, and language.

To view your output online or to save your output to a file, select the Save all Output Files check box.

  **Note:** Some requests have a required Style, Printer, or Language value that you cannot change.

8. **Specify delivery options for Internet Printing Protocol (IPP) printer, E-mail, Fax, FTP, WebDAV, or Custom.**

9. **Review your choices, make any necessary changes, and submit your request.**

**Multiple Organizations Reporting**

Multiple organizations reporting improves reporting capabilities of Oracle E-Business Suite by allowing reporting across operating units.

An operating unit is an organization that uses Oracle Cash Management, Order Management and Shipping Execution, Oracle Payables, Oracle Purchasing, and Oracle Receivables. An operating unit is associated with a legal entity and may be a sales office, a division, or a department. Information is secured by operating unit for these
applications, and you see information only for your operating unit.

When multiple organizations reporting is active, a list of available operating units is enabled when you enter the **Program Name**. Choose the operating unit to run your report against and continue submitting your request.

**Request Sets**

1. Choose the **Request Set Name** from the list of available request sets.
   Use the **Copy...** option to choose and submit a request set that you have previously submitted from this responsibility.

2. Define the parameters, layout, notification, and printer output information for each report or program listed in the request set.

3. Define the schedule.
   Specify when you would like this request set to run. See Request Submission, page 3-15.

4. Review your choices, make any necessary changes, and submit your request set.
   **Note:** Each report or program contained in the request set is assigned its own ID so that its status can be monitored individually on the Requests page.

**Default Parameter Values for Requests**

Parameters can have default values that are generated dynamically; for example, based on the current value of a profile option. A "Recalculate Default Parameters" option is available for copying requests or submitting new requests that are run periodically. This option determines if the parameter values should be recalculated. The default value of this option varies based on the request.

**Monitoring Requests**

The **Requests** window allows you to:

- View the status of your submitted requests.
- Change processing options.
- Diagnose errors.
- View your request output.
• Submit a new request or request set.
• Copy a request or request set.
• Rerun a request.

When the Auto Refresh check box is selected, the form will refresh the list of requests after a specified interval measured in seconds. Use the profile option Concurrent: Auto-refresh View Request Timer (secs) to set this interval.

**Important:** You can view only those requests to which you have been granted access by an administrator.

**Request Phase and Status**
A request has a life cycle consisting of the following phases: pending, running, and completed. If a request is on hold or unable to run, the request is placed in an inactive phase.

During each phase, a request has a specific status. Listed below are the possible statuses for each phase:

- **Pending Phase** - Normal, Standby, Scheduled, Waiting
- **Running Phase** - Normal, Paused, Resuming, Terminating
- **Completed Phase** - Normal, Error, Warning, Cancelled, Terminated
- **Inactive Phase** - Disabled, On Hold, No Manager

For more information about the status of your request, select the Diagnostics button in the Requests window.

**Finding Requests**
1. Open the Requests window (navigation varies by application).

   When you open the Requests window, you are directed to the Find Requests window.

2. Define your search criteria.

   **Note:** You can use the Specific Requests region to view a list of requests that you did not submit by entering a requestor other than yourself. However, you can only view details, output, and log files for requests submitted by you or your responsibility.
3. Select Find.

**Options for Requests in Progress**

Hold or cancel pending requests from the Requests window using the Hold Request or Cancel Request buttons.

View request diagnostics by selecting the Diagnostics button. The Request Diagnostics window displays information about the request run. The window may contain a View XML button to display the generated XML data, if applicable.

You can change completion and scheduling options for requests that meet the following criteria:

- You made the initial request.
- The request has not yet run.
- The program does not prevent request updates.

**To Change Options for a Request in Progress**

1. Select the request from the list.

2. Select the View Details... button to launch the Request Detail window.
   - To update a request's schedule, select the Schedule... button.
   - To update a request's completion options, select the Options... button from the Upon Completion... region.

**Viewing Request Output**

Reports are displayed in a browser, in the Report Viewer, or in another application registered by your system administrator. Reports that produce an output other than a text file, such as HTML or PDF, are displayed in a browser.

Set the profile option Viewer: Text to "Browser" to display your text files in a browser. If your system administrator registered other applications for viewing reports, select your text viewer application using the profile option Viewer: Application for Text. If this profile option is not set, you get a choice of applications when you view the report.

For more information about these profile options, see Defining Preferences with User Profile Options, page 3-23.

**To View Request Output**

1. Navigate to the Requests window.

2. Select the completed request and select the View Output button.
Tip: To view request log files: Select the View Log button.

To save request output displayed in the Report Viewer
1. Choose Copy File... from the Tools menu to display the Viewer Option window.
2. Select an output file format. This action opens your browser window.
3. From the browser window, use your browser’s tools to save your request output to a file.

Republishing or Reprinting Requests
1. Select the request and choose the Republish icon or choose Republish... from the Tools menu.
2. To Reprint a request, enter printing options.
3. To Redeliver a request, enter in options for Email, IPP Printer, Fax, FTP, WebDAV, or Custom as appropriate.

Requests with multiple layout templates can be republished using a different template.

Saving Reports from Your Browser
You can use the Save As functionality of your browser to save an HTML report to your desktop. Ask your system administrator for assistance if your browser does not display your language’s character set clearly.

Exporting Records to a File
Use the export feature to save the records in a multi-row block to a tab-delimited file. Open the file in the application of your choice.

To start an export
1. Query the records you want to export.
2. Place your cursor in the multi-row block that contains the records to be exported.
3. Choose Export... from the File menu.

Exporting Large Numbers of Records
Export, by default, selects all the records retrieved by the query. If the number of records exceeds 100, you are prompted to:
Stop - Limit the export to those records you have explicitly selected. Alternatively, cancel the export.

Continue to End - Export all records retrieved by the query.

**Important:** Avoid exporting a very large number of records as system performance can be affected.

Continue - Select the next 100 records for export. You are prompted every 100 records until all records are selected, or you choose Stop or Continue to End.

Oracle E-Business Suite Attachments

Use the Attachments feature to link text or other files to a record.

The Attachments... toolbar icon is enabled when the attachments feature is available. If the current record already has an attachment, the icon appears to hold a piece of paper.

**To open the Attachments window**

- Click the toolbar icon or choose Attachments... from the View menu.

**To add a new attachment**

1. Select a Category from the list of values. The Category defines the purpose of an attachment and controls which forms or pages can access it.

2. Select the attachment Data Type from the list of values:
   - Short Text - Enter text with a maximum length of 4000 bytes.
   - Long Text - For longer text attachments.
   - File - Launch the Upload a File window in your browser. Select the Browse button to locate the file in your file system or enter the file location in the File field.
   - Web Page - Your cursor advances to the URL field on the Source tab of the window. Enter the URL for the Web page.

3. Optionally add a title for your document.

4. Select the May Be Changed check box to allow changes to the attachment.

**To attach a document from the Document Catalog**

1. Choose the Document Catalog... button to open the Document Catalog window.

2. Use the Find Existing Documents region to query existing documents. Matching
documents are returned in the **Documents** region.

**Note:** To copy an attachment from another record, use the **Attached To:** field to select the application object you want to copy attachments from.

3. To view a document before attaching it, select it and then choose the **Preview** button.

4. Select the document(s) to attach.

5. Choose the **Attach** \((n)\) button, where \(n\) is the number of documents selected.

**To view an attached document**

In the **Attachments** window, select the attachment you want to view. If the attachment does not automatically display in the document block, select the **Open Document** button to view the document in a browser.

**To delete a record's attachment**

When you delete an attachment, you can remove the association between the record and the attached document or remove the attached document from the file system or database.

1. In the **Attachments** window, select the document to delete.

2. Choose **Delete** from the **Edit** menu.

3. Select a button in the **Decision** window to remove either the **Document and Attachment** or just the **Attachment**.

---

**Defining Preferences with User Profile Options**

Use profile options to modify the way your applications run.

Oracle E-Business Suite supports a set of user profile options that are common to all applications. In addition, each application has its own set of user profile options. See your application’s documentation for information on application-specific profile options.

**Profile Hierarchy**

Most profile options can be set at four levels:

- **Site** - affects all applications installed at a site.
- **Application** - affects a specific application.
- Responsibility - affects the applications assigned to a specific responsibility.

- User - affects the applications run by a specific user.

A User-level setting overrides a Responsibility-level setting, which overrides an Application-level setting, which overrides a Site-level setting.

Your system administrator sets options at all four levels. You can change options only at the User level.

**Note:** Some profile options can be set at the Server or Organization level.

### Setting Profile Options

Use the **Profile Values** window to display and change your user profile options.

**Note:** There are some profile options that you can view but not change. For example, you can view the value for **Concurrent:Request Priority**, which is set at the User level, but only your system administrator can change its value.

If you do not set a user profile option, it assumes a default value set either by your system or your system administrator.

**To set a profile option**

1. Navigate to the **Profile Values** window (navigation varies by application.)
   - To view a specific profile, use **Find** or **Query by Example**.
     The **Profile Values** window displays the **Profile Name**, **Default Value**, and **User Value**.

2. Enter a value in the **User Value** field or choose a value from the list of values, if available. To accept the default setting, clear the **User Value** field.
   **Important:** Number and date values are not validated. Ensure that you enter a valid number or date, or the associated profile option may not work as you expect.

3. Choose **Save** from the **File** menu or select the **Save** toolbar icon.
   **Note:** Some profile option changes do not take effect until you change responsibilities or restart your session.
Common Profile Options

**Flexfields: Open Key Window On Default**
Controls whether a flexfield window opens when you press Tab to leave a concatenated key flexfield.

If this profile option is set to Yes, the window opens if at least one of the segments has a default value defined. When you tab from the concatenated flexfield, the code automatically defaults defined values and opens the window to allow you to make changes.

If the profile option is set to No, then the flexfield window will not open for modifications, and assumes you want the defaulted values as part of the combination.

**Flexfields: Open Descr Window**
Controls whether a descriptive flexfield window automatically opens when you navigate to it. Valid values are *Yes* or *No*.

**Folders: Allow Customization**
Determines whether you can personalize folders. Valid values are:
- *Yes* - you can create or customize folder definitions.
- *No* - you can open only existing folder definitions.

*Note:* Only the system administrator can update this profile option.

**Indicate Attachments**
Turns off the indication of attachments when querying records (for performance).

*Note:* Only the system administrator can update this option.

**Printer**
Use this option to define your printer.

**Sign-On: Notification**
Determines if a tip message describing the number of open workflow notifications appears on the Home Page.

**Viewer: Application for Text**
If your system administrator has registered other applications for viewing text output, select the application from the list of values. The profile option *Viewer: Text* must be set to *Browser* to use this profile option.
Viewer: Text

Sets the display viewer for text report output. Valid values are *Browser* and *Report Viewer*. 
Overview of Enterprise Command Centers

Enterprise Command Centers (ECC) provide information discovery along with visualization and exploration capabilities embedded within Oracle E-Business Suite user interfaces. Oracle Enterprise Command Center Framework enables the creation of business dashboards in different functional areas. Oracle E-Business Suite users navigate transactional information using interactive visual components and guided discovery capabilities allowing exploratory data analysis. Mobility and responsive design are built into the Oracle Enterprise Command Center Framework, and all dashboards automatically adjust the layout to better fit a desktop or mobile device form factor. Oracle Enterprise Command Center Framework automatically adheres to existing Oracle E-Business Suite security. The dashboard content a user sees is completely consistent with the Oracle E-Business Suite context and security.

Each Oracle Enterprise Command Center extends the owning Oracle E-Business Suite application with discovery-oriented dashboards that bring together diverse operational data from across the Oracle E-Business Suite. ECC dashboard users identify and act on top priorities without the need for custom operational reporting, and use information-driven navigation. With tools and visualizations such as actionable indicators, tag clouds, interactive charts, and consumer-like search and filters, users can browse and drill on whatever engages their attention. With each drill-down or search refinement, the data engine recalculates indicators, tag clouds, charts, and search choices to provide the user with new information on which to base the next discovery steps. Through this "conversation with the data", users narrow in on today’s most important business challenges, all without predefined navigation paths, structured queries, or operational reports.

Having identified the most pressing business challenges, users seamlessly transition to detailed transaction screens to take immediate and informed action. Transaction screens are pre-populated with the results of information discovery; no re-querying of data is required. Users can switch between information discovery and transaction screens as they work their way through a set of identified problems, retaining the current
discovery context.

Oracle Enterprise Command Center Framework is built on scalable architecture comprising the following three main layers:

- ECC User Interface and UI Designer - Modern and interactive UI components with a browser-based designer that allows dashboard content creation through a drag-and-drop framework and fully declarative controls.

- ECC Service Interface - REST-based APIs that control the creation and retrieval of data and metadata. They provide advanced capabilities for data retrieval such as aggregations, associations, rollups, and more.

- ECC Core - A storage and query engine that enables the definition of data sets along with customized behaviors, relationships, calculations, and more.

Using Oracle Enterprise Command Centers, you can:

- Browse and drill on actionable indicators
- Use consumer-like search and filters
- Drill down with all indicators and search choices recalculated
- Through "conversation with the data", narrow in on most important priorities
- Navigate to selected transactions to take action

For more information, see: Using Enterprise Command Centers, page 4-3 and Highlights of an Enterprise Command Center, page 4-4.
Using Enterprise Command Centers

Example of an Enterprise Command Center Dashboard

Each Enterprise Command Center has a set of features that allows users to answer essential questions, uncover business insights, and drill down to take the relevant action. It helps users quickly and intuitively analyze data so they can make confident decisions driven by data.

Oracle Enterprise Command Center Framework brings an interaction paradigm between business users and data in their system of records. Rather than relying heavily on operational reporting, whether custom or out of the box, or using traditional search-and-results interfaces, Oracle Enterprise Command Center Framework transforms that into an interactive engagement.

Oracle Enterprise Command Center Framework relies on the concept of guided
navigation through data to achieve information discovery. This approach presents a high level overview of the data to users, based on their roles and access levels. Users then take whatever path they want through the data to explore different aspects. Through their interactions, Oracle Enterprise Command Center Framework guides them with multi-faceted search, cascaded drill-downs, type-ahead suggestions, highlighted keywords, and more.

For information on administering or extending Enterprise Command Centers, refer to the separate documentation on the Oracle E-Business Suite Documentation Library.

Highlights of an Enterprise Command Center

Oracle Enterprise Command Center Framework provides a flexible toolset for creating dashboards in different functional areas. The following are some features that enable you to handle diverse scenarios and obtain several types of insights.

Page Layout

Oracle Enterprise Command Center Framework provides the following page layouts:

- Side Navigation (default): In this default page layout, the side navigation panel that contains the search, selected refinement, and available refinements components are always displayed on the page.

- Collapsed Side Navigation: In this page layout, the side navigation panel is collapsed by default and can be expanded by clicking the "Toggle Navigation Panel" icon. When the side navigation panel is collapsed, the Selected Refinements component is displayed as a floating icon on the page. When the side navigation panel is expanded, this icon no longer appears.

- No Side Navigation: This page layout lets you display a page without the side navigation panel. This layout is best suited for a landing page or home page that will not have any navigation components. However, the Selected Refinements component is displayed as a floating icon after any filter is applied.

Search

Oracle Enterprise Command Center Framework comes with search capabilities that allow users to search for a term within a particular data. To do a basic search, type your search term into the search box. A list of attribute values containing the search terms is displayed, and you can select a value from the list to search for it or click on the magnifying glass (search icon) to retrieve all records containing this value.
The Search box supports the following capabilities:

- Look and Feel: The search box appears at the page level instead of in the side navigation panel. This look and feel provides easy-to-read search term highlighting and keyboard navigation for the auto-suggestion list.

- Multi-Data Set: In the products where the search box is configured with more than a single data set, the user can switch among the data sets to search for values from each data set to apply as filters. The name of the selected data set then appears
above the component.

**Example 1 of a Search Box with a Multi-Data Set**

<table>
<thead>
<tr>
<th>eAM: Assets</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search...</td>
</tr>
</tbody>
</table>

**Data Set**

- eAM: Assets
- eAM: Asset Attributes

**Example 2 of a Search Box with a Multi-Data Set**

**Service Request**

<table>
<thead>
<tr>
<th>Search...</th>
</tr>
</thead>
<tbody>
<tr>
<td>No filters selected</td>
</tr>
</tbody>
</table>

**Data Set**

- Service Request
- Service Task

- Search Attribute: You can choose a context under which you want to perform your search. The context can be configured to refer to any attribute in the system. Inline search within the context attribute is also supported.

For example, if you are using Oracle iProcurement and would like to shop for a monitor, you can select the Computer Monitor category from the Search drop-down menu. Then you start searching for a monitor, a specific list appears that applies to the selected category.

- Search Behavior: If you select a search attribute, additional controls let you choose how to display the remaining values of context attributes based on the current filter state on the page.

You can remove applied filters from the search box by changing their selection from the attribute list.

- Hyperlink: You can now search and navigate to another page and apply the search term as a filter on the destination page.

- Condition: The search box supports applying a data set condition on the suggestion list results.

If you search for two terms in the search box, the "AND" operator is applied by default between the terms, and values which match each term are returned, even if the terms are not in the same order. For example, a search for *office furniture* returns...
furniture-office because it matches both office and furniture.

**Search Example using 'AND'**

<table>
<thead>
<tr>
<th>Asset Category</th>
</tr>
</thead>
<tbody>
<tr>
<td>FURNITURE-OFFICE</td>
</tr>
<tr>
<td>FURNITURE-OFFICE MACHINE</td>
</tr>
</tbody>
</table>

Oracle Enterprise Command Center Framework also has advanced search capabilities in the search box as wildcard, phrase, and Boolean search with complex expressions.

**Phrase Search**

Phrase Search allows you to search for an exact sequence of terms using quotation marks (" "). For example, searching for "phillip taylor" returns only records with phillip taylor (case-insensitive).

**Phrase Search Example**

<table>
<thead>
<tr>
<th>Ship-To Customer</th>
</tr>
</thead>
<tbody>
<tr>
<td>Phillip Taylor</td>
</tr>
<tr>
<td>Salesperson</td>
</tr>
<tr>
<td>Taylor, Phillip Charles</td>
</tr>
<tr>
<td>Bill-To Contact</td>
</tr>
<tr>
<td>Liz Taylor</td>
</tr>
</tbody>
</table>

**Wildcard Search**

Wildcard or partial search used when you are searching for a term where you only know a few letters. By default when you start typing your search term in the search box, a trailing wildcard (*) is implicitly added at the end of the word. For example, a search for work returns all values with terms that start with work; for example, PC WORKSTATION, and WORKSTATIONS.
Example of a Wildcard Search

<table>
<thead>
<tr>
<th>Asset Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MP2006 Network computer</td>
</tr>
<tr>
<td>NETWORK UPGRADE</td>
</tr>
<tr>
<td>PC WORKSTATION</td>
</tr>
<tr>
<td>NETWORK SOFTWARE</td>
</tr>
<tr>
<td>NETWORK</td>
</tr>
<tr>
<td>WORKSTATIONS</td>
</tr>
</tbody>
</table>

Also, you can use (*) or (%) at the beginning and end of the search term, and the results will match any text that contain the characters between the search operators, even if the text occurs in the middle of a word. For example, with a search for *work* or %work%, all values that have 'work' are returned in the search results. (*) or (%) perform a multiple character wildcard search that looks for 0 or more characters. For example, a search for *work* returns values such as PC WORKSTATION, NETWORK, and WORKSTATIONS.

Example of a Search using ‘*’

<table>
<thead>
<tr>
<th>Asset Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MP2006 Network computer</td>
</tr>
<tr>
<td>NETWORK UPGRADE</td>
</tr>
<tr>
<td>PC WORKSTATION</td>
</tr>
<tr>
<td>NETWORK SOFTWARE</td>
</tr>
<tr>
<td>NETWORK</td>
</tr>
<tr>
<td>WORKSTATIONS</td>
</tr>
</tbody>
</table>

To perform a single (one and only one) character wildcard search use the “?” symbol. For example, a search for ?and returns LAND, and a search for ??and returns STAND.
Boolean Search

You can include logical operators in the search to set more precise search logic based on the operators listed below:

**Note:** Boolean operators must be in capital letters only: AND, OR, and NOT.

**Boolean Search Operators**

<table>
<thead>
<tr>
<th>Boolean Search Operator</th>
<th>Purpose</th>
<th>Example Usage and Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>AND</td>
<td>Returns results with all specified terms.</td>
<td>cip AND addition&lt;br&gt; Returns results with both 'cip' and 'addition'</td>
</tr>
<tr>
<td>OR</td>
<td>Returns results with any specified terms.</td>
<td>desktop OR laptop&lt;br&gt; Returns results with either 'desktop' or 'laptop'</td>
</tr>
<tr>
<td>NOT</td>
<td>Negates the following term (Will not retrieve records that have the unwanted keyword).</td>
<td>desktop NOT monitor&lt;br&gt; Returns results with ‘desktop’ but not ‘monitor’</td>
</tr>
</tbody>
</table>

Operator precedence is determined in the following order:

1. Any sub-expressions in parentheses are evaluated first
2. NOT is evaluated before other operators

3. AND is evaluated after NOT

4. OR is evaluated after AND

Expressions

An expression is used to build a more complex search query. You can combine keywords with AND, OR, or NOT. Use parentheses () to determine the relationship between operators when more than one operator is used. For example, a search for (computer OR desktop) NOT monitor returns records that contain both the words 'computer' and 'desktop' but do not contain 'monitor'.

Selected Refinements

The Selected Refinements region allows you to view and understand how the applied filters are displayed and grouped based on refinement operator.

In the Selected Refinements region, filters are grouped as described below:

- With the same attribute and same operator, filters are displayed in the same accordion

**Example of the Same Attribute and Operator in Selected Refinements**

- With the same attribute but different operators, filters are displayed in different accordions

**Example of the Same Attribute but Different Operators in Selected Refinements**

- With different attributes and different operators, filters are displayed in different accordions
Example of Different Attributes and Operators in Selected Refinements

<table>
<thead>
<tr>
<th>Selected Refinements</th>
<th>★</th>
<th>🔄</th>
</tr>
</thead>
<tbody>
<tr>
<td>eAM: Assets &gt; Organization</td>
<td>FAC</td>
<td>🔄</td>
</tr>
<tr>
<td>eAM: Assets &gt; Asset Criticality</td>
<td>High</td>
<td>🔄</td>
</tr>
<tr>
<td>eAM: Assets &gt; Owning Department</td>
<td>HQ-Cps</td>
<td>🔄</td>
</tr>
</tbody>
</table>

Breadcrumbs

The Breadcrumbs feature is an intuitive representation of the selected refinements as a trail of filters.

The Breadcrumbs feature is configured along with the search box on the page. It places emphasis on the sequence, or path, that the user has chosen to arrive at the current state of the dashboard.

Filters in the sequence are separated by their corresponding data set names with controls to remove individual values. Filters of the same attribute are placed next to one another, and hierarchical filters are separated by ‘>’.

Example of Selected Refinements as Breadcrumbs

If there are more than three filters of the same attribute, all the filters are grouped and collapsed with an icon. Clicking on the icon displays all the filters of the attribute. You can also remove all the filters of this attribute at once.
Available Refinements

The Available Refinements region allows interactive navigation of the data without your having prior knowledge of its spread and characteristics. Available Refinements presents you with all available possible values of an attribute through facets, date ranges, and number ranges.

As you interact with available refinement components or perform filtering operations from other components on the page, Available Refinements will dynamically update its list to display relevant attributes and attribute refinements. This navigation is data driven and supports progressive disclosure of additional options as appropriate, according to your navigation path through the data.

You can search for a specific attribute value using the search box embedded in the Available Refinements region. The minimum number of search characters is 2 to help you to find some search terms like 'IT'.

The Available Refinements feature includes an option to perform a 'Like' search. This type of search supports pattern matching when you enter a search string with wildcards or a Boolean expression. Click the magnifying glass icon displayed next to the attribute for the search to take effect on all page components.
The Available Refinements feature also supports categorizing the attributes in a logical grouping using attribute groups.

**Negative Refinements**

Negative Refinements allows you to refine the data by filtering out the selected values. Such refinements are displayed in selected refinements with an "Exclude" icon indicating them as negative refinements. To apply a negative refinement, you click the "Exclude" icon. The icon is visible only when hovered on the attribute value or navigated using the keyboard.
Example of Selecting a Negative Refinement

Available Refinements

- Asset
  - Asset Number
  - Category
- Asset Type
  
Search...

Capitalized (953)
CIP (9)
Group Asset (2)

Example of a Negative Refinement

Selected Refinements

- Assets > Asset Type
  - Capitalized

You can also exclude more than one attribute by clicking the icon for all the required exclusions.

Also, if a search is done, the Exclude All button excludes all the search results.

Negative refinements change the refinement behavior of multi-select AND attribute to multi-select OR as well as conversely.

Behavior Matrix for Refinement Selections

<table>
<thead>
<tr>
<th>Negative Refinement Selection</th>
<th>Single Assignment, Positive</th>
<th>Single Assignment, Negative</th>
<th>Multiple Assignment, Positive</th>
<th>Multiple Assignment, Negative</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single Selection</td>
<td>=</td>
<td>&lt; &gt;</td>
<td>N/A</td>
<td>N/A</td>
</tr>
</tbody>
</table>
### Multi-Data Set

The Available Refinements feature also allows you to apply the appropriate filters from multiple data sets. When two or more data sets are configured under Available Refinements, you can switch among the data sets to find and apply your desired refinements. The name of the data set selected appears in the component header as a title.

The Available Refinements feature allows you to select and apply filters from multiple data sets. You can switch among the data sets to find and apply selected refinements.

#### Example of a Multi-Data Set

![Example of a Multi-Data Set](image)

### Attribute Group

An attribute group is a logical grouping of attributes for display purposes. Attribute groups provide ease of navigation through Available Refinements.

For example, in an Assets application, the attributes could be grouped into the following: Asset Details, Category, Financial Details, Sources, and Assignments. The Asset Details attribute group contains the attributes Manufacturer Name, Model Number, Serial Number, and so on.

Attributes are then displayed in a hierarchical order based on the attribute groups.

Oracle Enterprise Command Center Framework supports advanced scrolling functionality by limiting the height of refinements section by the height of the dashboard.
Saved Search

Oracle Enterprise Command Center Framework provides an option to save frequently-applied filters or preferred filters as saved searches for future use. All saved searches are context-sensitive to the page and are part of the search suggestions. The list of saved searches appears when the focus is on the search component. Saved searches are searchable by their title, filter attributes, and filter values.

Three types of saved searches are available for users: seeded, public, and private. Seeded saved searches are published along with the product. Administrators can create public saved searches. Users can create their own private saved searches. Private saved searches are accessible only by the users who created them whereas public saved searches are accessible by all the dashboard users.

To create a saved search:

- Add refinements to the dashboard.
- Click the star icon in Selected Refinements header.
- To create a public saved search, check the Public Saved Search check box.
- Enter a title for the saved search and click Save.
- Once a saved search is created, the star icon is highlighted.

**Example of Creating a Saved Search**

![Saved Search Example](image)
Saved Search Example

To search and apply a saved search:

1. Place your cursor inside the search box to get a list of saved searches.
2. All seeded searches are grouped separately, and public saved searches are marked.
3. Enter a search query to refine the list.
4. Click on a saved search.

Example of Applying a Saved Search

To delete a saved search:

- Apply a saved search.
- Click the star (highlighted) icon.
- Click Delete.

The following instructions describe how to edit a saved search.

For editing the saved search name:

- Apply a saved search.
• Click the star icon.
• Update the name.
• Click Save.

For editing the filter state:
• Delete the saved search.
• Update filter state.
• Click the star (highlighted) icon.
• Enter the previous saved search’s name.
• Click Save.

To copy or modify a public saved search:
• Apply a public saved search.
• Add or delete filters, if necessary.
• Click the star icon.
• Update the name.
• Click Save to create a private saved search.

---

**Data Visualization**

Oracle Enterprise Command Center Framework has a set of graphs and charts that provide a powerful way of summarizing and presenting data that are critical in decision making in an easily comprehended manner. You can find insights, detect outliers, filter the data directly from the charts, and drill down to a deeper level of details. The following examples show how charts and graphs are used to detect and solve several problems or highlight bottlenecks and exceptions.

**Summarization Bar**

As the name implies, metrics, flags and dimensions in the bar summarize important aspects of the data displayed. All values are updated with new calculation results when you change the focus as you filter the data.

The summarization bar supports conditional formatting. With conditional formatting, a metric item can be displayed in a specific color based on a specific value or range of values, so that the color changes depending on the value of the metric.
Summarization Bar Example

You can apply a filter from a metric item in the summarization bar; this filter can be based on a static condition. For example, "Draft Orders" could be based on static conditions (open flag = Y AND booked flag = N). Also, the filter can be based on a variable condition. For example, the "My SRs" metric is based on service requests assigned to the logged-in user. In this case, the condition changes based on the logged-in user.

Numbers may be abbreviated for improved readability. The actual value is displayed in the tooltip.

Example of Abbreviation in Summarization Bar

Values in the summarization bar are displayed according to the number formatting specified for the Oracle E-Business Suite instance and are translatable.

Example 1 of Number Formatting in Summarization Bar

Example 2 of Number Formatting in Summarization Bar

Charts

Charts depict data trends, distributions, anomalies, and more. You can drill down through different levels of hierarchy and allow the system to expose different levels of details dynamically. You can control which options to slice the data by and affect the whole navigation path by picking filters directly from the charts.

Charts are effective when there is numerical data that splits nicely into different
categories so you can quickly see trends within the data, compare related information, and gain immediate insight.

**Example of a Horizontal Bar Chart**

**Example of a Bar-Line Chart**
You can refine the displayed data by clicking the data point on the chart. Also, by hovering the mouse over a chart, you can display the dimension and metric value for a data point.

Also, you can make the following refinements:

- Click a data point on the chart to refine the data by all of the applicable dimension values
- Click a label on the category axis to refine the data by that value only
- Click a legend entry to refine the data by that value only
A multi-metric chart supports the display of multiple metrics. Each metric shares the same axis. In a multi-metric chart, the bars are grouped by a series dimension.

With this chart, you can visually compare metrics against a shared dimension. For example, an organization could have a number of projects. A multi-metric chart could be used to compare the planned versus the actual quantity of a resource per project, or it could be used in a comparison of cost and revenue per project.

**Multi-metric Bar-Line Chart**
A multi-metric bar-line chart supports the display of multiple bar metrics and line metrics. Bar metrics and line metrics have their own axes, respectively. A series of dimension groups the metrics. With this chart, you can visually compare metrics against a shared dimension.
Example of a Multi-Metric Bar/Line Chart

Stacked Bar-Line Chart
A stacked bar-line chart supports the display of bar metrics aggregated over a series dimension and grouped by a group dimension. Line metrics are aggregated over a group dimension. Bar metrics and line metrics have their own axes, respectively.

Example of a Stacked Bar/Line Chart

Line Chart (With Group Dimension)
A stacked bar chart can be converted to a line chart at runtime, which then displays the aggregations as lines.
Example of a Line Chart (With Group Dimension)

Asset Number (Count Distinct) by Year Placed in Service, Asset Category

Line Chart with Data Points
Line chart and Bar/Line charts include a line series with data point, giving a clear indicator of the values. From the runtime options, you can control the display of data points.

Example of a Line Chart with Data Points

Line Smoothing
Line chart and Bar/Line charts can be displayed with smoothed line series. The representation of a smoother line is well-suited for continuous data with minimal variation and can give a clear visualization of trends. The smoothed line also displays data points controlled by runtime options.
Top N in Charts
The Top N feature in charts can be used to include just the essential information by rendering the chart with a subset of dimensions to display only the first N dimensions in the chart. Top N takes the Sort definition into account for considering the first N dimensions. The number of dimensions displayed can be controlled from runtime options, if configured.

Top N is applicable for all chart types apart from pie and donut chart types, if the group dimension is configured.

In Bar and Bar/Line chart types, if the chart has a group dimension, then Top N uses the group dimension; otherwise, it uses the series dimension.

In Bubble, Scatter chart types, Top N always uses the group dimension.

Example of Top N in a Chart
When configured, the order of display is also controlled from runtime options to
display the N dimensions from first or last. This is valid for charts with a timeline or a rolling window where the chart renders data for a rolling window of last N days/times.

**Example of Top N Chart with Order of Display**

![Top N Chart Example](image)

**Pie and Donut Charts**

Pie charts show a single metric aggregated across a group dimension.

**Example of a Donut Chart**

**Units Assigned (Sum) by Location**

![Donut Chart Example](image)

You can hover the mouse over a wedge or segment to display the corresponding metric value as well as its percent of the total.
"Other" in Pie/Donut Charts

The readability of the pie chart is improved by grouping dimensions with lower metric values based on a threshold percentage, thereby reducing UI clutter. All the dimensions corresponding to a percentage lower than the threshold are grouped into the "Other" group. If configured, the threshold limit is also controlled from runtime options. "Other" is always displayed last in the legend. "Other" considers sorting based on the metric -- when sorted in ascending order, "Other" is the first group and when sorted in descending order, "Other" is the last group. "Other" always displayed at the end of the legend regardless of the sorting option on the dimension; the user can filter by "Other" from the chart to drill down to data grouped in Other; also, the user can't filter by "Other" from chart legend.

Example of "Other" in a Pie Chart

Scatter Chart

A scatter chart is used to plot two metrics against each other. Scatter charts are used to find clusters of data points, to show gaps, and to identify sub-populations. Example use cases include cause and effect analysis (a driving factor and a dependent one), or analysis of the correlation of two variables, for example, the analysis of the relationship between cash inflow and outflow per project.

You can define the dimensions of the data used in the scatter chart. The group dimension (for example, location) controls the shapes of the data point display. The series dimension controls the number of data points with a particular shape. A data point is displayed at the intersection between the $x$ and $y$ metrics.
**Scatter Chart Example**

A scatter chart is used to plot two metrics against each other with an additional metric represented as the bubble size. Scatter charts are used to show concentrations of data along two axes with magnitude. For example, they could be used to illustrate performance review ratings or customer profitability.

You can define the dimensions of the data used in the scatter chart. The group dimension controls the bubble color. The series dimension controls the number of bubbles with the same color. A data point is displayed at the intersection between the $x$ and $y$ metrics.

**Bubble Chart**

A bubble chart is used to plot two metrics against each other with an additional metric represented as the bubble size. Bubble charts are used to show concentrations of data along two axes with magnitude. For example, they could be used to illustrate performance review ratings or customer profitability.

You can define the dimensions of the data used in the bubble chart. The group dimension controls the bubble color. The series dimension controls the number of bubbles with the same color. A data point is displayed at the intersection between the $x$ and $y$ metrics.
**Reference Line**

A reference line in a chart can be used to identify a specific value on a chart axis. The value can be based on a function, such as the average, maximum, or minimum. It is a constant value. The reference line is available only for a defined metric, for example, Invoice Amount (sum).

You can add more than one reference line to a chart. You can add a separate line for each metric defined, or you can add several reference lines for the same metric, using different functions associated with each one.

Reference lines are supported in all types of charts except pie and donut charts.
Example of a Reference Line in a Chart

Chart Maximization
The Chart Maximization feature improves the readability of the chart by providing visibility to more dimensions in the chart. You can maximize a chart and increase its height by dragging the right bottom corner of the chart. Change in height scales the axis dynamically and displays the chart height as a tooltip.

Example of Chart Maximization

Tag Cloud
A tag cloud highlights keywords in the system based on a configured importance metric. For example, a tag cloud could show top (or bottom) suppliers by invoice count, invoice amounts, and so on.
Example of a Tag Cloud

You can change the attributes of the Tag Cloud by using the Options icon.

Cascading Breadcrumbs

Cascading Breadcrumbs display the trail of cascading dimension values that give users a good understanding of the drill-downs that led to the display of the current dimension. In Chart and Tag Cloud components, cascading breadcrumbs are displayed on the top right corner when the components are cascaded. Cascading breadcrumbs are displayed when the user drills down from the component itself or even if the component is auto-cascaded due to any filter.

Example of Cascading Breadcrumbs in a Chart

Units Assigned (Sum) by Location

- United States of America
- California
- San Francisco

Location
- none
- Building 1
- Sales
- Office 1
- Office 2
- Building 100
- 02_Class
- 03_Class
- 04_Class
- 05_Class
- 06_Class
- 07_Class
- 08_Class
- 09_Class
- 10_Class

Amount (1)
Price (3)
Dist Variance (57)
Qty Rec (2)

IPM_INVALID_PC_HOLD (12)
IPM_VERIFICATION_HOLD (83)
IPM_INVALID_SUPPLIER_HOLD (4)

Line Variance (586)

Qty Ord (1)
Detailed Insights

Oracle Enterprise Command Centers can offer detailed insights into the data through results tables and grids which help you gain insight as quickly as possible. You can then act on it by taking the necessary action to resolve a process bottleneck or address an exception.

On some results tables and grids you can use the Options icon to compare records or perform other functions.

For record search only, you can control the order of the search results based on the record score in the data set. Data is sorted by "Score" by default. You can override this default order or add more sort options when you configure a dashboard. This ranking is supported only in results tables and grids.

Results Table

A results table displays 10 records per page by default, and when expanded, it displays 50 records per page.

A results table can include the display of attributes as visual indicators or images.

You can switch among groups to display data corresponding to a group.

A results table supports row-level actions for a single record and menu actions for more than one record.

Example of a Results Table

| Asset Details | | |
| --- | --- | --- | --- | --- | --- | --- |
| Retire Asset | Asset Number | Asset Description | Date Placed in Service | Service Life in Years | Remaining Life | Asset Cost | Accumuli |
| | | | | | | | |
| TEST 1 | cap asset | Aug 31, 2007 | 3 | 80% | 120,000 |
| 143762 | Admin Building | Aug 31, 2007 | 30 | 69% | 1,000,000 |
| 109351 | Monitor | Jul 31, 2007 | 3 | 78% | 483 |
| 109350 | Software | Jul 31, 2007 | 5 | 87% | 871 |
| 109349 | Laptop | Jul 11, 2007 | 3 | 76% | 2,982 |
| 109348 | Desktop | Jul 11, 2007 | 3 | 76% | 3,045 |
| 109343 | Software | Dec 31, 2006 | 5 | 75% | 819 |

0 record(s) selected.

Page 1 of 64 (1-10 of 638 items)

Grid

A grid offers a display of records in a flexible layout.

Grid functionality includes:

- Runtime Sorting: Business users can sort by any attribute displayed at runtime.
- Pagination Control and Selection: Pagination control and record selection can be
removed from a grid to support additional business use cases for the grid.

- Text Formatting: You can change the text style, alignment, size, and color.

**Example of a Grid**

![Example Grid Image]

**Compare Window**

You can compare records in a results table or grid. The Compare window also allows you to compare among the records view information of attribute values. Attributes are organized into corresponding groups if configured.

The Compare window can also have dynamic titles as column headers. The column headers in the Compare window can include tokens to display a dynamic title for each record based on an attribute value.

Grid actions can also be accessible from the column headers of the window.
**Example of a Compare Window**

**Comparing 2 Record(s)**

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Deluxe Laptop Monitor</th>
<th>Quantity: 1</th>
<th>Standard Laptop Monitor</th>
<th>Quantity: 1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Shopping Category</td>
<td>Others</td>
<td></td>
<td>Others</td>
<td></td>
</tr>
<tr>
<td>Shopping Category</td>
<td>Monitors</td>
<td></td>
<td>Monitors</td>
<td></td>
</tr>
<tr>
<td>Content Type</td>
<td>Catalog Items and Services</td>
<td></td>
<td>Catalog Items and Services</td>
<td></td>
</tr>
<tr>
<td>Content Type</td>
<td>This item has pre-negotiated pricing</td>
<td></td>
<td>This item has pre-negotiated pricing</td>
<td></td>
</tr>
<tr>
<td>Item Number</td>
<td>XC5002</td>
<td></td>
<td>XC4002</td>
<td></td>
</tr>
<tr>
<td>Supplier Contract</td>
<td>Agreement 4407</td>
<td></td>
<td>Agreement 4407</td>
<td></td>
</tr>
<tr>
<td>Supplier</td>
<td>Advantage Corp</td>
<td></td>
<td>Advantage Corp</td>
<td></td>
</tr>
<tr>
<td>Refinements</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Preferred Supplier</td>
<td>false</td>
<td></td>
<td>false</td>
<td></td>
</tr>
<tr>
<td>Eco-Friendly Supplier</td>
<td>true</td>
<td></td>
<td>true</td>
<td></td>
</tr>
<tr>
<td>Green Supplier</td>
<td>true</td>
<td></td>
<td>true</td>
<td></td>
</tr>
</tbody>
</table>

**Record Details Window**

The Record Details window allows you to view all the significant information of a record in a tabular format. Attributes in a Record Details window can also be organized into respective groups if configured. Similar to the Compare window, the Record Details window also supports dynamic titles and column header grid actions.
Runtime Action with a Postback Enhancement

Users can invoke Oracle E-Business Suite actions directly from the dashboard using a subset of records or all the records in the results table. This capability is subject to the configuration in the component. Actions configured with this functionality become active even when no records are selected. Also, users are warned if the number of records used by the menu actions exceed the limit set in the configuration.
Example of a Runtime Action with a Postback Enhancement

Results Table with a Function Call

JavaScript functions can be invoked corresponding to each record in the results table.

Example of Results Table with Function Call

Aggregated Table

An aggregated table displays aggregated metrics in tabular format. The aggregation level is controlled by all dimensions displayed in the table. Examples of aggregated tables include the comparison of the financial information of multiple assets, or the comparison of account balances.

The aggregated table also displays 50 records per page when maximized.
Example of an Aggregated Table

<table>
<thead>
<tr>
<th>SLA Account Description</th>
<th>Subledger Balance</th>
<th>General Ledger Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>Asset Clearing</td>
<td>-17.96M</td>
<td>-286.71M</td>
</tr>
<tr>
<td>Computers &amp; Software</td>
<td>5.45M</td>
<td>138.85M</td>
</tr>
<tr>
<td>Vehicles</td>
<td>6.27M</td>
<td>29.33M</td>
</tr>
<tr>
<td>Furniture</td>
<td>7.88M</td>
<td>35.27M</td>
</tr>
<tr>
<td>Machinery &amp; Equipment</td>
<td>9.77M</td>
<td>85.78M</td>
</tr>
<tr>
<td>CIP Cost</td>
<td>-4.7954K</td>
<td>-12.50M</td>
</tr>
<tr>
<td>Inventory Material Value</td>
<td>-12.81M</td>
<td>-179.72M</td>
</tr>
<tr>
<td>Equipment Expense</td>
<td>-4,000.00K</td>
<td>-4.00M</td>
</tr>
<tr>
<td>Accum.Depr.Vehicles</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>CIP Clearing</td>
<td>-175.18K</td>
<td>-500.90K</td>
</tr>
</tbody>
</table>

The Grid feature also supports displays aggregated metrics. All dimensions in the grid control the aggregation level. Aggregation leverages all the visible grid items driven by attributes, including images and indicators.

An aggregated grid has all the flexible layout and formatting options available for the grid. The grid does not allow filtering based on the aggregated value.

Aggregated grids do not have options for comparison and record details. The aggregated grid can be controlled to display data when a specific condition is met.

The aggregated grid also supports number abbreviations to improve readability in grid.

Example of an Aggregated Grid

<table>
<thead>
<tr>
<th>Top 5 Suppliers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Advantage Corp</td>
</tr>
<tr>
<td>Allied Manufacturing</td>
</tr>
<tr>
<td>Consolidated Supplies</td>
</tr>
<tr>
<td>Advanced Network Devices</td>
</tr>
</tbody>
</table>

Export

Export in Results Table and Grid

Records in results table and grid can be exported in a CSV file format. The exported file contains records organized in a tabular structure with attribute keys and attributes names as table headers. The exported file contains selected refinements on the page and timestamp of export.

To Export:

1. Click Export in runtime options to open a window with export options. The title of
the new window is the component title or data set name when there is no component title, followed by the number of records.

2. Rename the default file name. The default file name is component title or data set name appended by timestamp.

3. Choose standard or custom delimiter.

4. Choose the Attributes to export.

5. Choose the number of records.

6. Choose if hidden attributes and primary key needs to be included.

7. Choose if the file needs to be compressed.

**Example of an Export Window**

![Example of an Export Window](image)

**Export in Aggregated Table and Aggregated Grid**

Records in a results table or grid can be exported in a CSV file format. The exported file contains records organized in a tabular structure with attribute keys and attributes names as table headers.

The exported file honors all the runtime changes and contains selected refinements on the dashboard and timestamp.

Unlike in results table and grid, Export pop-up in the aggregated table and aggregated grid do not display the number of records in the pop-up header and pagination range.

To Export:
1. Click **Export** in runtime options to open a window with export options. The title of this window is the component title, or data set name when there is no component title.

2. Rename the default file name. The default file name is component title or data set name appended with a timestamp.

3. Choose standard or custom delimiter.

4. Choose the number of records (Only for aggregated grid).

5. Choose if the file needs to be compressed.

**Example of an Export Window for Aggregated Grid**

![Example of an Export Window for Aggregated Grid](image)

**Export in Chart**

The Chart component can be exported as a PNG image that contains a snapshot of the chart. The snapshot contains the chart as-is seen on the dashboard to honor runtime changes and any change in size with chart maximization.

To export the chart image, click on the camera icon in runtime options.

Underlying data of the chart component can also be exported in a CSV file. Exported data also honors all the runtime changes. As the underlying data needs to be holistic, exported data of chart contains all the data even if TopN is configured.

1. Click **Export** in runtime options to open a window with export options. The title of this window is the component title.

2. Rename the default file name. The default file name is component title or data set name appended with a timestamp.

3. Choose standard or custom delimiter.

4. Choose if the file needs to be compressed.
Export in Tag Cloud

The underlying data of the Tag Cloud component can be exported in a CSV file. Exported data also honors all the runtime changes. As the underlying data needs to be holistic, exported data of chart will contain all the data irrespective of how many dimensions are displayed.

To Export:

1. Click Export in runtime options to open a window with export options. The title of this window is the component title.

2. Rename the default file name. The default file name is component title or data set name appended with a timestamp.

3. Choose standard or custom delimiter.

4. Choose if the file needs to be compressed.

Example of Export Window for a Tag Cloud

Example of Exporting a Tag Cloud

Page Display Preferences

User changes to runtime options of components are saved as Page Display Preferences. You can log in again or navigate back to the dashboard to see all your changes intact. These changes persist until you explicitly reset either at the component level or page.
Component level reset resets the changes done to the component whereas page-level reset resets change across the dashboard. The following changes are maintained across the components:

**Components and Retained Changes**

<table>
<thead>
<tr>
<th>Component</th>
<th>Changes Retained</th>
</tr>
</thead>
<tbody>
<tr>
<td>Available Refinements</td>
<td>Data set selected</td>
</tr>
<tr>
<td>Search Component</td>
<td>Data set selected</td>
</tr>
<tr>
<td></td>
<td>Category value</td>
</tr>
<tr>
<td>Chart Component</td>
<td>Runtime selection of dimensions and metrics</td>
</tr>
<tr>
<td></td>
<td>Runtime sorting changes</td>
</tr>
<tr>
<td></td>
<td>Changes to chart orientation and stacking</td>
</tr>
<tr>
<td></td>
<td>Show as line</td>
</tr>
<tr>
<td></td>
<td>Show multi-metric</td>
</tr>
<tr>
<td></td>
<td>Split Y-axis for bar/line</td>
</tr>
<tr>
<td></td>
<td>Number of dimensions displayed</td>
</tr>
<tr>
<td></td>
<td>Order of Display</td>
</tr>
<tr>
<td>Tag Cloud</td>
<td>Runtime selection of dimensions and metrics</td>
</tr>
<tr>
<td>Tab Component</td>
<td>Selected Tab will be stored in session but not as a preference</td>
</tr>
<tr>
<td>Aggregated Table</td>
<td>Selected Attributes and Metrics from Runtime</td>
</tr>
<tr>
<td></td>
<td>Runtime Sorting</td>
</tr>
<tr>
<td>Results Table</td>
<td>Runtime Sorting</td>
</tr>
<tr>
<td>Grid</td>
<td>Runtime Sorting</td>
</tr>
</tbody>
</table>

You can reset using an icon that appears when a change is made. At component level, the Reset icon is in runtime options of the component. At the page level, the component is in the side navigation panel or on the top left of the dashboard.
Using Help

Getting Help

To get help

1. Choose Window Help from the Help menu, click the Help button on the toolbar, or press Ctrl+h to display help for the current window:

2. Navigate to the Contents tab to display online help for any of the Oracle E-Business Suite products.

   Note: You can also choose Oracle Applications Library from the Help menu.

1. Click on a product name to display the list of top-level topics in that product’s online documentation.

2. Click on a topic of interest.

3. Navigate to the Search tab to find specific Oracle E-Business Suite information. Simply enter your search criteria in the text field and then press Go. For more search options click on the Advanced Search link.

For more information see Searching For Help, page A-1.

Searching For Help

You can perform a search to find the Oracle E-Business Suite help information you want.

1. Choose Window Help from the Help menu or click the Help button on the toolbar.
2. Navigate to the **Search** tab, enter your search criteria in the text field, then press **Go** to perform a simple search. For more search options click on the **Advanced Search** link.

A list of titles, ranked by relevance and linked to the documents, is returned from your search.

3. Click on whichever title seems to best answer your needs to display the complete document.

   **Tip:** If the selected document doesn't fully answer your questions, use the browser's back button to return to the list of titles and try another.

---

**Simple Search**

Simple search implies that the search should return documents that contain any expression entered in the search field.

The following table lists examples:

<table>
<thead>
<tr>
<th>Use This Syntax</th>
<th>To Find Documents Containing ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>concurrent managers</td>
<td>the word &quot;concurrent&quot; or the word &quot;managers&quot;</td>
</tr>
<tr>
<td>&quot;concurrent managers&quot;</td>
<td>the phrase &quot;concurrent managers&quot;</td>
</tr>
</tbody>
</table>

**Advanced Search**

The advanced search feature contains these options:

- All Words
- Any Words
- Boolean

**All Words**

The *All Words* option implies that the search should return documents that contain ALL of the expression entered in the search field. For example, if you enter the expression *system administration*, the system finds documents containing both "system" and
Any Words

The *Any Words* option implies that the search should return documents that contain ANY of the expression entered in the search field. For example, if you enter the expression *system administration*, the system finds documents containing either "system" or "administration".

Boolean

The *Boolean* option implies that the search should return documents based on the truth value of the expression entered in the search field. The values for the valid operators that you can use are shown in the following table:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>And</td>
<td>AND, and, &amp;, +</td>
</tr>
<tr>
<td>Or</td>
<td>OR, or,</td>
</tr>
<tr>
<td>Not</td>
<td>NOT, not, -, ~</td>
</tr>
</tbody>
</table>

The following table lists examples:

Usage Examples of Boolean Operators

<table>
<thead>
<tr>
<th>Use This Syntax</th>
<th>To Find Documents Containing ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;concurrent manager&quot; &amp; &quot;profile options&quot;</td>
<td>the phrases &quot;concurrent manager&quot; and &quot;profile options&quot;</td>
</tr>
<tr>
<td>&quot;menu options&quot; - &quot;profile options&quot;</td>
<td>the phrase &quot;menu options&quot; and not the phrase &quot;profile options&quot;</td>
</tr>
<tr>
<td>menu &amp; menuitem</td>
<td>the words &quot;menu&quot; and &quot;menuitem&quot;.</td>
</tr>
<tr>
<td>profile</td>
<td>options</td>
</tr>
<tr>
<td>((profile &amp; categories) - options)</td>
<td>the words &quot;profile&quot; and &quot;categories&quot; and not the word &quot;options&quot;</td>
</tr>
</tbody>
</table>

"administration".

Any Words

The *Any Words* option implies that the search should return documents that contain ANY of the expression entered in the search field. For example, if you enter the expression *system administration*, the system finds documents containing either "system" or "administration".

Boolean

The *Boolean* option implies that the search should return documents based on the truth value of the expression entered in the search field. The values for the valid operators that you can use are shown in the following table:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Valid Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>And</td>
<td>AND, and, &amp;, +</td>
</tr>
<tr>
<td>Or</td>
<td>OR, or,</td>
</tr>
<tr>
<td>Not</td>
<td>NOT, not, -, ~</td>
</tr>
</tbody>
</table>

The following table lists examples:

Usage Examples of Boolean Operators

<table>
<thead>
<tr>
<th>Use This Syntax</th>
<th>To Find Documents Containing ...</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;concurrent manager&quot; &amp; &quot;profile options&quot;</td>
<td>the phrases &quot;concurrent manager&quot; and &quot;profile options&quot;</td>
</tr>
<tr>
<td>&quot;menu options&quot; - &quot;profile options&quot;</td>
<td>the phrase &quot;menu options&quot; and not the phrase &quot;profile options&quot;</td>
</tr>
<tr>
<td>menu &amp; menuitem</td>
<td>the words &quot;menu&quot; and &quot;menuitem&quot;.</td>
</tr>
<tr>
<td>profile</td>
<td>options</td>
</tr>
<tr>
<td>((profile &amp; categories) - options)</td>
<td>the words &quot;profile&quot; and &quot;categories&quot; and not the word &quot;options&quot;</td>
</tr>
</tbody>
</table>
("concurrent manager" & (request submission)) the phrase "concurrent manager" and the words "request" and "submission"
Oracle E-Business Suite Accessibility Features

Overview

This appendix describes accessibility features in Oracle E-Business Suite.

**Note:** The content of this appendix is cumulative, so it describes features in Oracle E-Business Suite up to and including those for the latest release.

Enabling Accessibility Features for the HTML-Based Interface

Set the Accessibility mode on the login page under **Accessibility**.

Alternatively, the accessibility mode can be set on the Preferences page under "Accessibility" or by using the profile option **Self Service Accessibility Features**.

Once the Accessibility mode is set, it does not need to be set again for future sessions.

The options are:

- **None:** Pages include behaviors that are not accessible.

- **Standard Accessibility:** Pages are accessible to keyboard-only users and those using assistive technologies such as screen magnifiers.

- **Screen Reader Optimized:** Pages are accessible to screen reader users.

  When Screen Reader Optimized mode is on, it adds extra information and may move content around so that pages work better with a screen reader.

Required Form Controls

Oracle E-Business Suite uses an asterisk (*) to indicate that a control is required. In
Screen Reader Optimized mode, the required field indicator asterisk (*) is associated with the form control and non-visible text "(required)" is appended to the label that can be read by screen readers.

Field-Level Hints

In Screen Reader Optimized mode, tip text is displayed on the left side of the input field, depending on language session being used. In None or Standard mode, tip text is displayed below the input field.

Keyboard Interaction in the HTML-Based Interface

The following components are covered:

- Attachments, page B-4
- Hide/Show Subtab Region, page B-4
- List Box, page B-4
- Look Ahead LOV, page B-4
- Panel Splitter, page B-5
- Pop-up Windows, page B-5
- Processing Page, page B-6
- Rating Bar, page B-6
- Rich Interactions of Tables, page B-6
- Rich Text Editor, page B-9
- Shuttle, page B-9
- Spin Box, page B-9
- Tiles, page B-10
- Subtabs, page B-10
- Top-level Menu, page B-11

Access Keys

Access keys can be enabled or disabled using the Disable Access Keys check box on the Preferences page.
Using Hot Keys

The following table lists the actions and associated hot keys that are supported in HTML-based applications.

To perform the action in Internet Explorer, press the Alt key + the key listed in the table. In this browser, the access key "activates" a button. That is, typing the access key moves the focus to the button and submits the associated action.

In Firefox on Windows, press Shift + Alt + the key listed in the table. In this browser, the access key places focus on the button but does not submit any action.

Actions and Associated Hot Keys

<table>
<thead>
<tr>
<th>Action</th>
<th>Hot Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Apply</td>
<td>p</td>
</tr>
<tr>
<td>Back</td>
<td>k</td>
</tr>
<tr>
<td>Cancel</td>
<td>l</td>
</tr>
<tr>
<td>Continue</td>
<td>c</td>
</tr>
<tr>
<td>Finish</td>
<td>i</td>
</tr>
<tr>
<td>Next</td>
<td>x</td>
</tr>
<tr>
<td>No</td>
<td>n</td>
</tr>
<tr>
<td>Save</td>
<td>s</td>
</tr>
<tr>
<td>Search</td>
<td>r</td>
</tr>
<tr>
<td>Submit</td>
<td>m</td>
</tr>
<tr>
<td>Yes</td>
<td>y</td>
</tr>
<tr>
<td>Right Subtab</td>
<td>&gt;</td>
</tr>
<tr>
<td>Left Subtab</td>
<td>&lt;</td>
</tr>
</tbody>
</table>

Note for Mac Users

On a Mac, you need to set a system preference to allow focusing on everything with just
the keyboard. Go to System Preferences > Keyboard and under the Shortcuts tab, click on the "All controls" radio button. Once the Full Keyboard Access is set to all controls, you can use the Tab key together with arrow keys to navigate items on the screen. Use the space bar to select screen item that is in focus.

Attachments

Enabled inline attachment pop-ups are focusable and are accessible by the Tab key. They may also be closed by pressing the Escape key.

Hide/Show Subtab Region

A Hide/Show subtab region contains a subtab layout that appears vertically on the page.

Using the keyboard, you can access the Hide/Show subtab layout by pressing the Tab key until focus reaches the first subtab of the layout. Pressing Tab again focuses on the subsequent component within that subtab.

To navigate between subtabs, use the navigation keys. Use the Down arrow key or Right arrow key to focus on the next subtab. Use the Up arrow key or the Left arrow key to focus on the previous subtab.

Inline Date Picker

When one or more date fields appear on a page, an Inline Date Picker may be displayed on the page, allowing users to quickly select dates for those fields.

- If you have the Self Service Accessibility Features profile set to "Screen Reader Optimized", the feature is not enabled. The date can be entered manually into the field without using the Inline Date Picker.

- If you have the Self Service Accessibility Features profile set to "Standard Accessibility" and there is more than one date field associated with the Inline Date Picker, you may need to enter the date manually into the fields or use the Date Picker pop-up window.

List Box

A list box lets a user select one or more values from a list.

With the focus on list box, pressing the Up or Down arrow key will shift the focus to the next item and select it. If Multi-Select Allowed is enabled, then holding the Shift key while pressing the Up/Down arrow key will select multiple items, if applicable.

Look Ahead LOV

The List of Values component has type-ahead search capabilities. As a user types in characters in the LOV search field, the results are fetched and displayed. The user can select a value from this look ahead window just as in the classic LOV window.
Keyboard navigation is as follows:

- **Down arrow** - Moves the focus to the first record if no record currently has the focus, or moves the focus to the next record if a record already has the focus.

- **Up arrow** - Moves the focus to the previous record. If the current record with focus is the first record, the Up arrow removes the focus from that record. If no record currently has focus, the Up arrow has no effect.

- **Tab** - Selects the current record with focus.

- **Escape** - Dismisses the Look Ahead LOV window without selecting a record.

- **Alt+< or Alt+Shift+, (comma)** - Navigates to the previous page of records.

- **Alt+> or Alt+Shift+. (period)** - Navigates to the next page of records.

- **Alt+r** - Opens the LOV window where you can refine your search.

- **Spacebar** - Selects the current value with focus.

  **Note:** The Look Ahead LOV is not available for Screen Reader Optimized mode.

**Panel Splitter**

If you have the Self Service Accessibility Features profile set to "Standard Accessibility" or "Screen Reader Optimized", use the following keys to interact with the panel splitter region.

- **Tab** - navigates focus onto the collapsible/expandable icon.

- **Left arrow or Down arrow** - with focus on the collapsible/expandable icon, moves the position of the splitter bar left or down.

- **Right arrow or Up arrow** - with focus on the collapsible/expandable icon, moves the position of the splitter bar right or up.

- **Enter** - with focus on the collapsible/expandable icon, expands or collapses the collapsible panel.

**Pop-up Windows**

Modal and non-modal pop-up windows are invoked by pressing the Enter key and navigable with the Tab and Shift+Tab keys. For modal pop-up windows, the focus stays within the pop-up until it is cancelled or submitted. For non-modal pop-up windows, pressing the F6 key moves the focus between the base page and current opened pop-up.
They may be closed by pressing the Escape key.

Processing Page

A Processing page lets users know that a long-running process is working in the background. When Screen Reader Optimized mode is on, the user gets a Refresh Status button and must press it to continue.

Rating Bar

A rating bar allows users to rate a product, service, or entity.

Use the following keys to interact with an updatable rating bar:

- Left arrow or Down arrow - moves the focus to the previous rating image of the rating bar. If the focus is already on the first rating image, pressing either of these keys shifts the focus to the last rating image of the same rating bar.

- Right arrow or Up arrow - moves the focus to the next rating image of the rating bar. If the focus is already on the last rating image, pressing either of these keys shifts the focus to the first rating image.

- Tab - moves the focus to the next page element. If the current focus is on the rating bar, pressing the Tab key shifts the focus to the next element on the page. If the current focus is on an element prior to a rating bar, pressing Tab moves the focus to the rated image of the rating bar. For example, if a rating bar rates a three out of five, then pressing Tab from a previous page element shifts the focus to the third image of the rating bar.

- Shift+Tab - moves the focus to the previous page element from the rating bar. If the previous page element is another rating bar, pressing Shift+Tab shifts the focus to the rated image of the previous rating bar.

- Spacebar or Enter - if focus is on a rating image on a rating bar, pressing the Spacebar or Enter key rates the current rating bar with that rating value. For example, if the focus is on the fourth star of a rating bar, pressing either of these keys rates the rating bar with four stars.

Rich Interactions of Tables

If you have the Self Service Accessibility Features profile set to "Standard Accessibility" or "Screen Reader Optimized", you may still take advantage of the following rich table interactions through a simpler user interface that does not require a mouse (except for resizing a column).

Actions

Use the Tab key or Shift+Tab key combination to move the cursor focus to the Actions icon in the control bar.
Press the Enter key to toggle the display of the menu.

Alternatively, with the focus on the Actions icon, you may press the Down arrow key to display the menu and move the focus onto the first item of the menu.

**Note:** Accessibility behavior may differ based on the language session used. For example, in an Arabic session Left arrow functions like the English Right arrow.

**To Detach a Table**

1. To move the cursor up or down between form fields of the same column of a detached table, use Alt+Up arrow or Alt+Down arrow key combinations, respectively. To move the cursor forwards or backwards between form fields, use the Tab key or the Shift+Tab key combination, respectively.

2. Use the Escape key to reattach the table to its base page.

**To Scroll Through a Table**

Users can scroll vertically and horizontally with Up/Down arrow keys and Left/Right arrow keys, respectively. In Screen Reader Optimized mode, rather than vertical scrolling, there is pagination so user may select the "Next" and "Previous" links to display next or previous sets of rows.

**To Reorder a Column**

1. Select the Columns option from the Actions menu. Use the Spacebar key or Right arrow key to display a list of the columns of the table.

2. Use the Up arrow key or the Down arrow key to navigate between column names, "wrapping" at the top and bottom of the menu.

3. With focus on a column name, press Control+Up arrow to move the column up the menu list, keeping focus on the moved column.

4. With focus on a column name, press Control+Down arrow to move the column down the menu list, keeping focus on the moved column.

5. With the focus on a column name, you can apply the change by pressing the Escape key which also closes the menu.

**To Hide/Show a Column**

1. Select the Columns option from the Actions menu. Use the Spacebar key or Right arrow key to display a list of the columns of the table.

2. Use the Spacebar key to move the focus to the column names in the menu.
3. Use the Up arrow key or the Down arrow key to navigate between column names, "wrapping" at the top and bottom of the menu.

4. With the focus on a column name, press the Spacebar key to check or uncheck the focused column name. A check shows the column.

5. With the focus on a column name, you can apply the change by pressing any of the following:
   - Escape - which also closes the menu and returns focus to the menu-enabled item.
   - Tab - which also closes the menu and navigates to the next item on the page.
   - Shift+Tab - which also closes the menu and moves focus back to the menu-enabled item.

To Resize a Column

Column resizing is not supported if the Self Service Accessibility Features profile is set to "Standard Accessibility" or "Screen Reader Optimized".

To Freeze a Column

If you have the Self Service Accessibility Features profile set to "Screen Reader Optimized", the column freeze feature is disabled.

If you have the Self Service Accessibility Features profile set to "Standard Accessibility", you can use the following keyboard commands.

1. Select the Freeze option from the Actions menu. Use the Spacebar key or Right arrow key to display a list of the columns of the table.

2. Use the Up arrow key or the Down arrow key to navigate between column names, "wrapping" at the top and bottom of the menu.

3. With the focus on a column name, press the Spacebar key to select the column to freeze.

4. With the focus on a column name, you can apply the change by pressing any of the following:
   - Escape, which also closes the menu and returns focus to the menu-enabled item.
   - Tab, which also closes the menu and navigates to the next item on the page.
   - Shift+Tab, which also closes the menu and moves focus back to the menu-enabled item.
5. Select Unfreeze from the Freeze menu to unfreeze a column.

Use the Left arrow or Right arrow keys to scroll the table horizontally.

**Table Selection**

The tri-state check box is used to select or deselect all of the rows in a table. The tri-state check box may be selected or deselected with the Spacebar key.

See: Querying and Viewing Data, page 2-4 for more information.

**Rich Text Editor**

The Rich Text Editor is rendered in Text Mode when the *Self Service Accessibility Features* profile is set to "Standard Accessibility" or "Screen Reader Optimized". When the profile is set to "None" then the Rich Text Editor is rendered in Rich Text Mode, along with a Switch Mode link.

**Shuttle**

A shuttle component is used to assemble a list of items, by moving or adding items from one list to another.

Keyboard navigation is as follows: press Tab or Shift+Tab to navigate through leading lists, trailing lists, and buttons.

For selection: with the focus on either the leading list box or trailing list box, pressing the Up arrow key or the Down arrow key will shift the focus to the next item and select it. If Multi-Select Allowed is enabled, you can select multiple items by holding the Shift key while pressing the Up or Down arrow key.

With the focus on any of the buttons (Move, Remove or Reorder), you can take the corresponding action on selected items by pressing Space.

**Spin Box**

A spin box allows a user to select a numeric value from a predefined range.

With the focus is on the spin box input field, the following keystrokes result in the given actions:

- Up arrow - increases the current value by the defined step size, as long as the maximum value has not been reached. If the maximum value displays, nothing happens.

- Down arrow - decreases the current value by the defined step size, as long as the minimum value has not been reached. If the minimum value displays, nothing happens.

- Tab - triggers the action associated with the spin box, if any.
• Page Up - same as Up arrow.
• Page Down - same as Down arrow.
• Home - set to maximum value.
• End - set to minimum value.

Subtabs
A subtab allows you to access a single page’s contents in a tabbed layout.

Horizontal and Vertical Subtabs
At runtime, users can navigate from one horizontal subtab to the next by using accelerator keys on the keyboard. Note that the accelerator keys do not cycle to the first subtab from the last subtab or to the last subtab from the first subtab.

• For Microsoft Internet Explorer, use [Alt] + [.] and [Alt] + [,]. These keys only focus on the subtab elements but do not activate them. To display the subtab content, you also need to press the [Enter] key.

• For Google Chrome, use [Alt] + [.] and [Alt] + [,]. These keys select and also activate the next and previous subtab in the browser respectively.

• For Mozilla Firefox, use [Alt] +[Shift]+[.] and [Alt] +[Shift]+[,] . These keys select and activate the next and previous subtab in the browser respectively.

Users can navigate from one vertical subtab to the next by using the up, down, left or right arrow keys and then press [Tab] to access the content within the vertical subtab layout.

Tiles
In general, keyboard interaction for tiles is similar to that for subtabs. The keyboard interactions common to both vertical and horizontal display mode of tiles are:

• Tab - moves focus to next page element. Note that only the active tile is in the tab order. If the current focus is on the active tile itself, pressing the Tab key shifts focus to the first "tab-able" element in the active tile's content region.

• Home - with focus on active tile, pressing the Home key shifts focus to the first tile of the tile list and activates that tile.

• End - with focus on active tile, pressing the End key shifts focus to last tile of the tile list and activates that tile.

• Control+Page Up - with focus anywhere within the tile's content region, pressing Control+Page Up shifts focus from the current tile to the previous tile and activates
it. If the currently selected tile is the first tile, then this action shifts the focus to the last tile and activates it.

- Control+Page Down - with focus anywhere within the tile's content region, pressing Control+Page Down shifts focus from the current tile to the next tile and activates it. If the currently selected tile is the last tile then this action shifts the focus to the first tile and activates it.

Keyboard interactions for **horizontal** display mode:

- Left or Right arrow - with focus on the active tile, pressing the Left/Right arrow key shifts focus to the previous/next (next/previous in a right-to-left session) tile in the tile list and activates it. If the currently selected tile is the last tile, pressing the Right arrow key (Left arrow key for a right-to-left session) shifts focus to the first tile. If the currently selected tile is the first tile, pressing the Left arrow key (Right arrow key for a right-to-left session) shifts focus to the last tile.

- Control+Up arrow- with focus anywhere within the tile's content region, pressing Control+Up arrow shifts focus to the currently selected tile.

Keyboard interactions for **vertical** display mode:

- Up arrow or Down arrow - with focus on the active tile, pressing the Up/Down arrow key shifts focus to the previous/next tile in tile list and activates it. If the currently selected tile is the last tile, pressing the Down arrow key shifts focus to the first tile. If the currently selected tile is the first tile, pressing the Up arrow key shifts focus to the last tile.

- Control+Left arrow (Right arrow in a right-to-left session) - with focus anywhere within the tile's content region, pressing Control+Left arrow (Right arrow in a right-to-left session) shifts focus to the currently selected tile.

**Top-level Menu**

With the Top-level Menu Display Style set to "Icons and Links", you can use the keyboard to navigate the top-level menu as follows:

- Tab - moves focus to the next page element. Only the active menu item of the top-level menu is in the tab order. With the focus on an active menu in the top-level menu, pressing the Tab key again shifts the focus to the next tab-able element in the content region.

- Home - with focus on an active menu, pressing the Home key shifts the focus to the first menu item of the top-level menu and activates that menu.

- End - with focus on an active menu, pressing the End key shifts focus to the last menu item of the top-level menu and activates that menu.
• Control+Page Up - with focus anywhere within a content region of a selected menu, pressing Control+Page Up shifts focus from the currently selected menu to the previous menu and activates it; if the currently selected menu is the first menu item in the top-level menu, then focus shifts to the last menu item in the top-level menu and activates it.

• Control+Page Down - with focus anywhere within a content region of a selected menu, pressing Control+PageDown shifts focus from the currently selected menu to the next menu and activates it; if the currently selected menu is the last item in the top-level menu, then focus shifts to the first menu item in the top-level menu and activates it.

• Left arrow/Right arrow - with focus on the active menu, pressing the Left arrow key or Right arrow key shifts focus to the previous or next (or next/previous in a right-to-left session) menu item in the top-level menu and activates it. If the currently selected menu is the last menu item in the top-level menu, pressing Right arrow (or Left arrow for a right-to-left session) shifts focus to first menu and vice versa.

• Control+Up arrow - with focus anywhere within a content region, pressing Control+Up arrow shifts focus to the currently selected menu.

**Accessibility in Forms-Based Applications**

Users with low vision can:

• Run forms with any color scheme set on the operating system by using the Generic look and feel or use one of several pre-defined schemes with the Oracle look and feel

• Turn off hard-coded colors

• Set operating system Font Size with DPI which affects the overall size of all items in a form

• Use a screen magnifier that supports Java.

Users with physical limits can:

• Run forms with just the keyboard

• Use access keys to activate menu items, push buttons, radio buttons, checkboxes

• Invoke the "List Tab Pages" function (typically mapped as F2) to switch tab pages

• Change forms keystroke mappings that are displayed in the "Keyboard Help"

• Use operating system accessibility features such as Sticky Keys and Toggle Keys
• Use a voice recognition program to give commands and enter data

Screen reader users can:
• Run forms with just the keyboard
• Use access keys to activate menu items, push buttons, radio buttons, checkboxes
• Invoke the "List Tab Pages" function (typically mapped as F2) to switch tab pages
• Change forms keystroke mappings that are displayed in the "Keyboard Help"
• Use operating system accessibility features such as Sticky Keys and Toggle Keys
• Run forms with a screen reader that supports Java such as JAWS or SuperNova
• Use Oracle E-Business Suite features that display all items and push buttons in a window
  • Key-F9 function -- Prompt/Value LOV (typically mapped as Ctrl+Shift+F9)
  • Key-F8 function -- Actions LOV (Typically mapped as Ctrl+Shift+F8)

• Use Oracle E-Business Suite feature called Forms Personalization to change "speakable prompts"

Hearing impaired users can:
• Turn on operating system accessibility feature SoundSentry to generate a visual warning when the system makes a sound

Configuration Steps for Screen Reader Users

Java Access Bridge

Oracle Forms supports the Java Access Bridge, which allows integration with assistive technologies that also support Java. The Java Access Bridge must be enabled so that Oracle Forms, the Java Runtime Engine (JRE) and the Java enabled assistive technology may interact. For information how to enable the Java Access Bridge, please see the Java Accessibility Guide at https://docs.oracle.com/javase/8/docs/technotes/guides/access/index.html.

Actions and Values LOVs

Oracle E-Business Suite incorporates a feature that allows any user to see the current screen in a compressed, text-only pop-up window format called LOV (List of Values). Fields which cannot take focus because they are 'non-navigable' will not allow a screen reader to read their value and prompt. To account for this, Oracle E-Business Suite has special code that presents all fields in the current window, as well non-navigable fields in the window in special LOVs. Included in the LOVs are the values of display items,
which otherwise would not be easily discernible with a screen reader because they are not keyboard navigable. These special text-only pop-up windows allow a screen reader user to quickly identify all widgets in the current window (but just the current row for multi-row blocks).

The 'Actions' LOV is invoked through the "KEY-F8" function and is a list of all push buttons in the current window. The 'Values' LOV is invoked through the "KEY-F9" function and is a list of all other widgets in the current window like text items, radio buttons, checkboxes and poplists. Each row in the LOV will be spoken by a screen reader. The LOVs are in alphabetical order. Both LOVs also show access keys for radio buttons, checkboxes and push buttons. Choosing a value from either the Actions or Values LOV will not cause focus to move to those fields or buttons.

The access keys displayed in the LOVs are within braces for translations purposes. For example, access key c is displayed as [C] and a screen reader will speak the text as "brace C brace". Check with the screen reader manufacturer if there is a way to change it to speak "Alt C" instead of "brace C brace" if this is annoying.

Note that the "KEY-Fn" function is not necessarily the "Fn" button on the keyboard. The current key mapping for the function can be shown in the "Keyboard Help" window. Typically the "KEY-Fn" function is mapped to Ctrl+Shift+Fn via the Oracle Terminal resource file.

**Forms Personalization**

Oracle E-Business Suite users can take advantage of a powerful feature called Forms Personalization if they don't like some of the "speakable prompts". My Oracle Support Note 395117.1 is available that explains Forms Personalization.

### Runtime options for users with low vision

#### Profiles Java Look and Feel and Java Color Scheme

Users with low vision may set the desired colors using the operating system’s provided schemes, then set profiles Java Look and Feel and Java Color Scheme.

- To specify the look and feel, set profile Java Look and Feel to either "generic" or "oracle".
- If the "oracle" look and feel is used, the profile Java Color Scheme can be specified as follows: "teal", "titanium", "red", "khaki", "blue", "olive", or "purple".
- The Java Color Scheme profile has no effect if Java Look and Feel is set to "generic".

#### Profile FND: Indicator Colors

Oracle E-Business Suite by default renders:

- Required fields are displayed in yellow.
- Queryable fields are displayed in a different color while in enter-query mode.
• Read-only fields are rendered in dark gray.

To turn off these features when running Oracle E-Business Suite Forms-based applications, set profile `FND: Indicator Colors` to "No".

**Font Size**

Operating system settings such as Font Size, will affect the overall size of all items in a form. Often this is the only technique to adjust font sizes within a form, as they typically are hard-coded.

Windows 7 operating system instructions:


2. Restart the computer.

3. Launch Forms and you should have a larger font.

**Runtime options for users with physical limits**

All items used within Oracle Forms follow the standard operating system conventions for keyboard use. For example, on the Microsoft Windows operating systems use Alt+ [letter] to activate items with access keys, Alt+down to open a poplist, and Alt to move focus to the menu. Oracle Forms should inherit operating system accessibility functions such as Sticky Keys. Tabs can be switched by invoking the "List Tab Pages" function (typically F2), in addition to using access keys on each tab label.

The "Keyboard Help" window displays the keystrokes to achieve normal Forms operations, such as 'Next Block' and 'Clear Record'. This window can be viewed at any time by pressing Ctrl+K. The keyboard mappings can be customized by the System Administrator. For more information, see the *Oracle E-Business Suite Setup Guide*.

A user running a screen reader will most likely need a modified keyboard mapping file, or will have to change the Assistive Technology keystrokes, as some of the default function mappings may conflict.

The following table lists common default Forms keystrokes on Microsoft Windows:

<table>
<thead>
<tr>
<th>Action</th>
<th>Keystroke</th>
</tr>
</thead>
<tbody>
<tr>
<td>List of Forms Keys</td>
<td>Ctrl+k</td>
</tr>
<tr>
<td>Next Record</td>
<td>Down Arrow</td>
</tr>
<tr>
<td>Action</td>
<td>Keystroke</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>Previous Record</td>
<td>Up Arrow</td>
</tr>
<tr>
<td>Next Field</td>
<td>Tab</td>
</tr>
<tr>
<td>Previous Field</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Next Field (From a Multi-Line Text Item)</td>
<td>Ctrl+Tab</td>
</tr>
<tr>
<td>Next Block</td>
<td>Shift+Page Down</td>
</tr>
<tr>
<td>Previous Block</td>
<td>Shift+Page Up</td>
</tr>
<tr>
<td>Actions LOV</td>
<td>Ctrl+Shift+F8</td>
</tr>
<tr>
<td>Values LOV</td>
<td>Ctrl+Shift+F9</td>
</tr>
<tr>
<td>Activate default push button in a window</td>
<td>Enter</td>
</tr>
<tr>
<td>if one exists</td>
<td>Pressing the Enter key with</td>
</tr>
<tr>
<td></td>
<td>the focus on a button will</td>
</tr>
<tr>
<td></td>
<td>activate that button. If the</td>
</tr>
<tr>
<td></td>
<td>focus is not on a button (or</td>
</tr>
<tr>
<td></td>
<td>menu item), then the Enter</td>
</tr>
<tr>
<td></td>
<td>key should activate the</td>
</tr>
<tr>
<td></td>
<td>default button if one exists.</td>
</tr>
<tr>
<td>Save Record (Commit)</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Clear Record</td>
<td>F6</td>
</tr>
<tr>
<td>Create Record</td>
<td>The standard keystroke may be</td>
</tr>
<tr>
<td></td>
<td>consumed by the screen reader,</td>
</tr>
<tr>
<td></td>
<td>so you need to run with</td>
</tr>
<tr>
<td></td>
<td>different terminal resource</td>
</tr>
<tr>
<td></td>
<td>file to map Ctrl+Down Arrow to</td>
</tr>
<tr>
<td></td>
<td>something else or just use the</td>
</tr>
<tr>
<td></td>
<td>pull-down menu.</td>
</tr>
<tr>
<td>Close Window</td>
<td>Ctrl+F4</td>
</tr>
<tr>
<td>List of Tab Pages</td>
<td>F2</td>
</tr>
<tr>
<td>Activate Menu</td>
<td>Alt and then navigate with up/</td>
</tr>
<tr>
<td></td>
<td>down and left/right arrow</td>
</tr>
<tr>
<td></td>
<td>keys</td>
</tr>
<tr>
<td><strong>Action</strong></td>
<td><strong>Keystroke</strong></td>
</tr>
<tr>
<td>---------------------------------------------------------------------------</td>
<td>---------------------------------------------------</td>
</tr>
<tr>
<td>Activate push buttons, radio buttons, checkboxes and topmost menu items</td>
<td>Alt+access key</td>
</tr>
<tr>
<td>Toggle between open/close poplist</td>
<td>Alt+Up/Down arrow keys</td>
</tr>
<tr>
<td>Activate current push button, Toggle checkbox yes/no</td>
<td>Spacebar</td>
</tr>
<tr>
<td>Cycle through and select a radio button within a radio group</td>
<td>Left/Right arrow keys and then Spacebar</td>
</tr>
<tr>
<td>Move to beginning of line</td>
<td>Home</td>
</tr>
<tr>
<td>Move to end of line</td>
<td>End</td>
</tr>
<tr>
<td>Select to end of line (there is no keystroke for &quot;Select All&quot;)</td>
<td>Shift+End or Shift+Insert+End</td>
</tr>
<tr>
<td>Cut</td>
<td>Ctrl+x</td>
</tr>
<tr>
<td>Copy</td>
<td>Ctrl+c</td>
</tr>
<tr>
<td>Paste</td>
<td>Ctrl+v</td>
</tr>
<tr>
<td>Select the current tree node</td>
<td>Spacebar</td>
</tr>
<tr>
<td>Activate the current tree node (this expands or contracts the node if it is not a leaf node)</td>
<td>Enter</td>
</tr>
<tr>
<td>Move up the tree</td>
<td>Up arrow</td>
</tr>
<tr>
<td>Move down the tree</td>
<td>Down arrow</td>
</tr>
<tr>
<td>Move up the tree branch one parent at a time collapsing nodes</td>
<td>Left arrow</td>
</tr>
<tr>
<td>Move down the tree expanding parent nodes</td>
<td>Right arrow key</td>
</tr>
</tbody>
</table>
List of Values

Oracle E-Business Suite includes a feature that renders an iconic button next to each field that has an LOV. The LOV can also be invoked from the keyboard by pressing the "List of Values" function (typically Ctrl+L).

Tab Pages

Tabs in Oracle E-Business Suite can only be changed from the keyboard using the "List Tab Pages" function. Individual tab labels do not have access keys due to translation issues.

Keyboard Interaction in the Oracle Enterprise Command Center Dashboards

This section describes keyboard interaction in Oracle Enterprise Command Center dashboards using Oracle Enterprise Command Center Framework.

**Note**: The following functions are not possible with keyboard only:

- Selection of multiple values from available refinements.
- Navigation across dimensions in the tag cloud and applying as refinements.

Navigation Components

The following table lists keyboard actions for functions within the Search component.

**Keyboard Navigation for the Search Component**

<table>
<thead>
<tr>
<th>Target</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reach Search Component</td>
<td>Use the Tab key.</td>
</tr>
</tbody>
</table>
### Target Navigation

<table>
<thead>
<tr>
<th>Target</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch Data Set</td>
<td>Reach options icon using Tab key.</td>
</tr>
<tr>
<td></td>
<td>Use the Enter key to open the options menu.</td>
</tr>
<tr>
<td></td>
<td>Use Arrow keys to select the data set.</td>
</tr>
<tr>
<td>Perform Search</td>
<td>Enter the search query.</td>
</tr>
<tr>
<td></td>
<td>Click Enter OR click Tab to move to magnifying glass icon, and then press Enter.</td>
</tr>
<tr>
<td>Select from suggestions</td>
<td>Enter the search query.</td>
</tr>
<tr>
<td></td>
<td>Use Arrow keys to navigate among search values.</td>
</tr>
<tr>
<td></td>
<td>Click Enter.</td>
</tr>
<tr>
<td>Use Search Category</td>
<td>Reach Search Category using Tab key.</td>
</tr>
<tr>
<td></td>
<td>Use the Down arrow key to view the list.</td>
</tr>
<tr>
<td></td>
<td>Navigate using Arrow keys.</td>
</tr>
<tr>
<td></td>
<td>Click Enter to select.</td>
</tr>
</tbody>
</table>

The following table lists keyboard actions for functions related to Selected Refinements.

### Keyboard Navigation for Selected Refinements

<table>
<thead>
<tr>
<th>Target</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reach Selected Refinements</td>
<td>For any page type, use the Tab key.</td>
</tr>
<tr>
<td>Clear All Refinements</td>
<td>Reach the Clear All Refinements icon using the Tab key.</td>
</tr>
<tr>
<td></td>
<td>Use the Enter key to remove refinement.</td>
</tr>
<tr>
<td>Remove Individual Refinements</td>
<td>Reach the Clear Refinement Icon using the Tab key.</td>
</tr>
<tr>
<td></td>
<td>Use the Enter key to remove refinement.</td>
</tr>
<tr>
<td>Navigate within funnel icon</td>
<td>Press Enter to open the Selected Refinements window.</td>
</tr>
<tr>
<td></td>
<td>Press F6 and Tab keys to navigate through.</td>
</tr>
</tbody>
</table>
The following table lists keyboard actions for functions related to Available Refinements.

**Keyboard Navigation for Available Refinements**

<table>
<thead>
<tr>
<th>Target</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reach Available Refinements</td>
<td>For any page type, use the Tab key.</td>
</tr>
<tr>
<td>Expand or Collapse Accordions of Attribute Group/Attributes</td>
<td>Reach accordions using the Tab key. Use Enter or Space keys to expand/collapse accordions.</td>
</tr>
<tr>
<td>Search within Attribute</td>
<td>Reach the Search Bar using Tab key. Enter search query. Press Enter or click Tab to move to the magnifying glass icon and press Enter for search.</td>
</tr>
<tr>
<td>Select value</td>
<td>Use Tab keys to move through the attribute values and press Enter.</td>
</tr>
</tbody>
</table>

The following table lists keyboard actions for functions related to the Breadcrumbs feature.

**Keyboard Navigation for Breadcrumbs**

<table>
<thead>
<tr>
<th>Target</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear Refinements</td>
<td>Use Tab keys to move to the Remove icon and press Enter.</td>
</tr>
<tr>
<td>Clear All Refinements</td>
<td>Use Tab keys to move to the Clear All icon and press Enter.</td>
</tr>
<tr>
<td>View Collapsed Filters</td>
<td>Use the Tab key to move to remove the icon and press Enter. Use the Enter key to open a pop-up list Use the Tab key to move to the list. Use the Tab key to clear filters in the list.</td>
</tr>
</tbody>
</table>
Visualization Components

The following table lists keyboard actions for functions related to the Summarization Bar.

**Keyboard Navigation for Summarization Bar**

<table>
<thead>
<tr>
<th>Target</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigate through</td>
<td>Use the Tab key to move the focus.</td>
</tr>
<tr>
<td>Apply metric refinement</td>
<td>Use the Enter key on the metric.</td>
</tr>
<tr>
<td>Open LOV from a flag</td>
<td>Use the Enter key on the flag.</td>
</tr>
<tr>
<td>Select a value from LOV</td>
<td>Use Arrow keys to move across rows.</td>
</tr>
<tr>
<td></td>
<td>Press F2 to move within a row.</td>
</tr>
<tr>
<td></td>
<td>Press enter to refine by dimension.</td>
</tr>
<tr>
<td></td>
<td>Close the LOV using the Escape key.</td>
</tr>
</tbody>
</table>

The following table lists keyboard actions for functions related to charts.

**Keyboard Navigation for Charts**

<table>
<thead>
<tr>
<th>Target</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigate across dimensions</td>
<td>Use Shift+Arrow keys to change focus on dimensions.</td>
</tr>
<tr>
<td>Apply Refinements</td>
<td>Use the Enter key on a dimension.</td>
</tr>
<tr>
<td>Use runtime options</td>
<td>Use the Tab key to reach runtime options.</td>
</tr>
<tr>
<td></td>
<td>Use the Enter key to open runtime options.</td>
</tr>
<tr>
<td></td>
<td>Use the Tab key to navigate across options.</td>
</tr>
<tr>
<td>Add Refinement</td>
<td>Use the Enter key.</td>
</tr>
</tbody>
</table>
Target Navigation for Aggregated Tables

<table>
<thead>
<tr>
<th>Target</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change the number of dimensions or other actions</td>
<td>Use the Tab key to reach runtime options.</td>
</tr>
<tr>
<td></td>
<td>Change the number of dimensions using number keys.</td>
</tr>
<tr>
<td></td>
<td>Change the order of display using arrow keys.</td>
</tr>
<tr>
<td></td>
<td>Change the threshold using number keys.</td>
</tr>
</tbody>
</table>

The following table lists keyboard actions for functions related to aggregated tables.

**Keyboard Navigation for Aggregated Tables**

<table>
<thead>
<tr>
<th>Target</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigate across rows</td>
<td>Use the Up Arrow and Down Arrow keys.</td>
</tr>
<tr>
<td>Navigate across items in a record</td>
<td>Use Arrow keys to move across rows.</td>
</tr>
<tr>
<td></td>
<td>Press F2 and Tab to navigate within a row.</td>
</tr>
<tr>
<td>Use runtime options</td>
<td>Use the Tab key to reach runtime options.</td>
</tr>
<tr>
<td></td>
<td>Use the Enter key to open runtime options.</td>
</tr>
<tr>
<td></td>
<td>Use Tab keys to navigate across options.</td>
</tr>
<tr>
<td>Add Refinements</td>
<td>Use the Enter key.</td>
</tr>
<tr>
<td>Sort column</td>
<td>Use the Tab key to navigate across column headers.</td>
</tr>
<tr>
<td></td>
<td>Use the Enter key to sort by the column.</td>
</tr>
<tr>
<td>Change pagination</td>
<td>Use the Tab and Enter keys.</td>
</tr>
</tbody>
</table>

**Detailed Insights Components**

The following table lists keyboard actions for functions related to results tables.
### Keyboard Navigation for Results Tables

<table>
<thead>
<tr>
<th>Target</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigate across rows</td>
<td>Use the Up Arrow and Down Arrow keys.</td>
</tr>
<tr>
<td>Navigate across items in a record</td>
<td>Use Arrow keys to move across rows.</td>
</tr>
<tr>
<td></td>
<td>Press F2 and Tab to navigate within a row.</td>
</tr>
<tr>
<td>Use runtime options</td>
<td>Use the Tab key to reach runtime options.</td>
</tr>
<tr>
<td></td>
<td>Use the Enter key to open runtime options.</td>
</tr>
<tr>
<td></td>
<td>Use Tab keys to navigate across options.</td>
</tr>
<tr>
<td>Add Refinements</td>
<td>Use the Enter key.</td>
</tr>
<tr>
<td>Sort column</td>
<td>Use the Tab key to navigate across column headers.</td>
</tr>
<tr>
<td></td>
<td>Use the Enter key to sort by the column.</td>
</tr>
<tr>
<td>Make Selection</td>
<td>Use Arrow keys to move across rows.</td>
</tr>
<tr>
<td></td>
<td>Use the Space key to select the record.</td>
</tr>
<tr>
<td></td>
<td>For multiple selections, use Shift key and navigate across rows.</td>
</tr>
<tr>
<td>Use row actions</td>
<td>Use Arrow keys to move across rows.</td>
</tr>
<tr>
<td></td>
<td>Press F2 and Tab keys to reach row actions.</td>
</tr>
<tr>
<td></td>
<td>Use the Enter key.</td>
</tr>
<tr>
<td>Change pagination</td>
<td>Use Tab and Enter keys.</td>
</tr>
</tbody>
</table>

The following table lists keyboard actions for functions related to results grids.

### Keyboard Navigation for Results Grids

<table>
<thead>
<tr>
<th>Target</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigate across grid cells</td>
<td>Use Up Arrow and Down Arrow keys.</td>
</tr>
</tbody>
</table>
### Target Navigation

<table>
<thead>
<tr>
<th>Target</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Navigate across items in a grid</td>
<td>Use Arrow keys to move across rows.</td>
</tr>
<tr>
<td></td>
<td>Press F2 and Tab to navigate within a row.</td>
</tr>
<tr>
<td>Use runtime options</td>
<td>Use the Tab key to reach runtime options.</td>
</tr>
<tr>
<td></td>
<td>Use the Enter key to open runtime options.</td>
</tr>
<tr>
<td></td>
<td>Use Tab keys to navigate across options.</td>
</tr>
<tr>
<td>Add Refinements</td>
<td>Use the Enter key.</td>
</tr>
<tr>
<td>Make Selection</td>
<td>Use Arrow keys to move across grid cells.</td>
</tr>
<tr>
<td></td>
<td>Use the Space key to select the record.</td>
</tr>
<tr>
<td></td>
<td>For multiple selections, use Shift key and navigate across grid cells.</td>
</tr>
<tr>
<td>Use grid items like input and button</td>
<td>Use Arrow keys to move across grid cells.</td>
</tr>
<tr>
<td></td>
<td>Press F2 and Tab keys to reach attributes.</td>
</tr>
<tr>
<td>Change pagination</td>
<td>Use Tab and Enter keys.</td>
</tr>
</tbody>
</table>

### Layout Components

The following table lists keyboard actions for the Tabbed Component Container.

#### Keyboard Navigation for a Tabbed Component Container

<table>
<thead>
<tr>
<th>Target</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch tab</td>
<td>Use Tab key to change focus and use the Enter key to switch tab.</td>
</tr>
</tbody>
</table>

### Other Component Controls

The following table lists keyboard actions for other components.
### Keyboard Navigation for Other Component Controls

<table>
<thead>
<tr>
<th>Feature</th>
<th>Navigation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Record Details</td>
<td>Use F2 to reach record details icon and use the Enter key. Use Escape key to close the window.</td>
</tr>
<tr>
<td>Compare</td>
<td>Use Arrow, Space, and Shift keys to make a selection. Navigate to compare in runtime options using Tab and press Enter. Use Escape key to close the Header.</td>
</tr>
<tr>
<td>Actions</td>
<td>Use the Tab key to navigate through column headers. Use F2 and Tab keys to navigate through header items.</td>
</tr>
<tr>
<td>Export</td>
<td>Use Arrow, Space and Shift keys to make a selection. Navigate to Export in runtime options using Tab and press Enter. Use the Tab key to navigate through options in the Export window. Use the Escape key to close the window.</td>
</tr>
<tr>
<td>Switch Data Set</td>
<td>Use the Tab key to navigate to switch data set option. Use the Up Arrow and Down Arrow keys to change the data set. Use Escape key to close the window.</td>
</tr>
<tr>
<td>Saved Search</td>
<td>Use the Tab key to navigate to the star icon. Use Enter to create/edit saved search window. Press F6 to navigate inside the window use the Tab to navigate within the window. Use Escape key to close the window.</td>
</tr>
</tbody>
</table>